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Before Using the Calculator

Read This First

About This Manual
• In no event shall CASIO Computer Co., Ltd. be liable to anyone for

special, collateral, incidental, or consequential damages in connection
with or arising out of the purchase or use of this product and items that
come with it. Moreover, CASIO Computer Co., Ltd. shall not be liable for
any claim of any kind whatsoever by any other party arising out of the
use of this product and the items that come with it.

• The contents of this manual are subject to change without notice.
• The displays and illustrations (such as key markings) shown in this

manual are for illustrative purposes only, and may differ somewhat from
the actual items they represent.

• QR Code is a registered trademark of DENSO WAVE INCORPORATED
in Japan and in other countries.

• Company and product names used in this manual may be registered
trademarks or trademarks of their respective owners.

Key Operations
The example below shows how key operations are represented in this
manual.

Example 1: 
Keys should be pressed in the sequence shown above (left to right).

Example 2: (π)*
The above indicates you should press  and then , which will input
a π symbol. All multiple-key input operations are indicated like this. Key
cap markings are shown, followed by the input character or command in
parentheses.
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* Refer to "Key Markings" (page 12) for more information about the key
symbols used in this example.

Example 3: , , , , , 

• Individual cursor keys indicated by (1) are represented as , , ,
.

• Individual page scroll keys indicated by (2) are represented as , .

Menu Operations
Some operations in this manual use a simplified form of menu operations,
as shown in the examples below.

Example 1

 – [Other] > [π]

or

Press , and then select [Other] > [π].

Actual Operation 1

1. Press .
2. Use  and  to select [Other], and then press .
3. Use  and  to select [π], and then press .

Example 2

 - Calculate

or
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Press , select the Calculate app icon, and then press .

Actual Operation 2

1. Press .
2. Use the cursor keys ( , , , ) to select the Calculate app icon,

and then press .

 Key and  Key
The  key and  key perform the same operation. In this manual,  is
used for selecting or applying a setting, while  is used for executing a
calculation. Note, however, that it makes no difference whether you press

 or  for operations where either  or  is shown.

Examples
If you are not instructed to use a specific calculator app or to configure
particular settings for an example operation, the app and settings below
are assumed.

Calculator app: Calculate
Settings: Initial default calculator settings

For information about returning the calculator to its initial default settings,
see "Initializing the Calculator" (page 7).

Initializing the Calculator

Important!

• The procedure below initializes all calculator settings, except for Contrast and Auto
Power Off. Also clears all data stored in calculator memory.

1. Press  to display the HOME screen.
2. Use the cursor keys ( , , , ) to select a calculator app icon,

and then press .
3. Press , and then select [Reset] > [Initialize All] > [Yes].

• This displays the HOME screen.

Calculator "Get Started" Screen
While the HOME screen is displayed, pressing the  key will display the
"Get Started" screen, which includes the information below.
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• QR Code for accessing the "Get Started" webpage of the Worldwide
Education Service (https://wes.casio.com/calc/cw/)
The Get Started webpage gives you access to the User’s Guide and
other related information to help you get started with your calculator.

• Calculator ID number (24-character string)

Press  to return to the HOME screen.

Note

• You can also display the Get Started screen, by selecting it from the SETTINGS menu.
See "Using the SETTINGS Menu" (page 17).

Precautions

Safety Precautions
Thank you for purchasing this CASIO product.
Be sure to read the "Safety Precautions" before using this product to
ensure that you use it correctly. Be sure to keep all user documentation
handy for future reference.

Warning
Indicates something that creates the risk of death or serious
personal injury.

 Display Screen

Do not press the LCD or subject it to strong impact.

Doing so can cause the LCD glass to crack, creating the risk of
personal injury.

Should the LCD become cracked, never touch any of the
liquid inside.

LCD liquid getting on the skin creates the risk of skin irritation.
Should LCD liquid get into your mouth, immediately rinse your mouth
out and contact your physician.
Should LCD liquid get in your eyes or on your skin, rinse with clean
water and then contact your physician.

8
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 Battery Precautions

Should fluid leaking from a battery get on your skin or
clothing, immediately rinse it off with clean water.

Battery fluid getting into the eyes creates the risk of eyesight loss, etc.
Rinse the eyes and then immediately contact a physician.

Caution
Indicates something that creates the risk of minor personal injury
or physical damage.

Observe the precautions below. Failure to do so can cause a
battery to rupture, creating the risk of fire, personal injury, and
soiling of nearby objects by leaking fluid.

• Do not try to take a battery apart and never allow a battery to
become shorted.

• Do not charge a non-rechargeable battery.
• Do not expose a battery to heat or throw it into fire.

• Use only the specified type of battery.
• Load a battery with its poles (plus (+) and minus (–)) facing

correctly.
• Replace the battery as soon as possible after it goes dead.

 Battery Precautions

Observe the precautions below. Failure to do so can cause
the battery to explode or leak flammable liquid or gas.

• Use only the type of battery that is specified for this product.
• Do not burn a battery or dispose of it in an incinerator, or by

mechanical crushing or cutting.
• Do not subject a battery to excessively high or low temperatures

during use, storage, or transport.
• Do not subject a battery to excessively low barometric pressure

during use, storage, or transport.

Handling Precautions
• Even if the calculator is operating normally, replace the battery at least

once every two years (R03).
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• You will be charged for malfunction or damage due to battery leakage,
which is not covered by the warranty.

• The battery that comes with the calculator discharges slightly during
shipment and storage. Because of this, it may require replacement
sooner than the normal expected battery life.

• Avoid use and storage of the calculator in areas subjected to
temperature extremes, and large amounts of humidity and dust.

• Do not subject the calculator to excessive impact, pressure, or bending.
• Never try to take the calculator apart.
• Use a soft, dry cloth to clean the exterior of the calculator.
• Whenever discarding the calculator or batteries, be sure to do so in

accordance with the laws and regulations in your particular area.

Getting Started

Attaching and Removing the Front Cover

To remove the front cover

Before using the calculator, remove the front cover (①) and attach it to the
back (②).
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To attach the front cover

When you are not using the calculator, remove the front cover (①) and
attach it to the front (②).

Important!

• Always attach the front cover to the calculator whenever you are not using it.
Otherwise, accidental operation of the  key can cause the power to turn on and
run down the battery.

Turning Power On and Off
Press  to turn on the calculator.
Press (OFF) to turn off the calculator.

Note

• To turn on power, long-press . To avoid turning on power accidentally, the top of
 key is slightly lower than the other keys.

• If the screen shown below appears right after you turn on power, it means that
remaining battery power is low.
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If this screen appears, replace the battery as soon as possible. For details about
battery replacement, see "Replacing the Battery" (page 105).

• The calculator also will turn off automatically after approximately 10 minutes or 60
minutes of non-use. Press the  key to turn the calculator back on.

HOME Screen
Pressing  displays the HOME screen. The HOME screen shows a list of
installed calculator apps.

  HOME Screen   Calculate App Screen
                 

For information about installed calculator apps, see "Installed Calculator
App List" (page 16).

Adjusting Display Contrast
1. Press , select a calculator app icon, and then press .
2. Press , and then select [System Settings] > [Contrast].

3. Use  and  to adjust display contrast.
4. After the setting is the way you want, press .

Important!

• If adjusting display contrast does not improve display readability, it probably means
that battery power is low. Replace the battery.

Key Markings
Pressing the  key followed by a second key performs the alternate
function of the second key. The alternate function is indicated by the text
printed above the key, on the left.

(1) Keycap function: 
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(2) Alternate function: (π)

Indicators
Indicators

The table below describes indicators that appear at the top of the screen.

This indicator: Means this:

The keypad has been shifted by pressing the 
key. The keypad will unshift and this indicator will
disappear when you press a key.

MathI/MathO or MathI/DecimalO is selected for
Input/Output on the SETTINGS menu.

 /  / 
Current setting of Angle Unit ( : Degree, :
Radian, or : Gradian) on the SETTINGS menu.

FIX A fixed number of decimal places is in effect.

SCI A fixed number of significant digits is in effect.

i/∠ Current setting of Complex Result (i : a+bi or ∠:
r∠θ) on the SETTINGS menu.

Verify is enabled (by selecting "Verify ON" on the
TOOLS menu).

 / 
There is previous ( ) or following ( ) calculation
history for the currently displayed calculation
result.

Using Menus
Many of the operations of your calculator are performed using menu
screens. The example below shows operations starting from the menu
screen that appears when you press .
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Selecting a Menu Item

To select a menu item, use the cursor keys ( , , , ) to highlight
it and then press . Note that  and  are used only when there are
multiple menu item columns.

Navigating Between Menu Hierarchies

The " " indicator to the right of a menu item means that there are lower
hierarchy levels under that item. Selecting the menu item and pressing 
or  navigates the next lower level of the hierarchy. To return to the next
upper level of the hierarchy, press .

Note

• If you are in a lower level of the hierarchy of a one-column menu, you can press  in
addition to  to return to the next higher level.

Selecting a Menu Item with a Radio Button ( / )

When the display shows a list of multiple options, each option will have a
radio button (  or ) to its left.  indicates the currently selected option.

To configure the setting of a radio button menu item
1. Highlight the applicable menu item and then press .

• What happens next depends on the type of menu item you selected.
- If there are no more settings to configure for the menu item you

selected, the radio button next to it will change to .
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- The menu item you selected has more settings to configure, a
screen for selecting the menu item setting will appear. In this case,
proceed to step 2.

2. On the setting screen, highlight the setting you want and then press .
• This returns to the menu item screen in step 1, with the radio button

next to the menu item you previously selected changed to .

Scrolling Between Screens

A scroll bar will appear along the right side of the display when there are
so many menu items that they do not fit on one screen.
• Use  and  to scroll between screens.
• Use  and  to scroll line-by-line.

To close the menu and return to the screen displayed before
the menu

Press .

Note

• You can close a menu displayed by pressing , , , , , or  by
pressing . If the displayed menu is one that appears immediately after launching
a particular calculator app or if it is an app-specific menu, you cannot close it by
pressing . In that case, you must press  to close the menu.
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Calculator Apps and Menus

Calculator Apps

Selecting a Calculator App
Select a calculator app that is suitable for the type of calculation you want
to perform.
1. Press  to display the HOME screen.

• For information about each calculator app, see the "Installed
Calculator App List" (page 16).

2. Use the cursor keys ( , , , ) to select the calculator app icon
you want.

3. Press  to display the initial screen of the calculator app whose icon
you selected.

Installed Calculator App List

Icon Description

(Calculate)*

General calculations

(Statistics)

Statistical and regression
calculations

(Distribution)

Distribution calculations
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(Table)*

Generates a number table based on
one or two functions

(Complex)*

Complex number calculations

(Vector)

Vector calculations

Note

• Verify, which is a function that determines the truth of an input equation or solution, is
available with the calculator apps marked with an asterisk (*) in the above table. For
information about Verify, see "Using Verify" (page 59).

Using the SETTINGS Menu
To display the SETTINGS menu, press  while using a calculator app.
The SETTINGS menu includes the menu items below.

Calc Settings
Includes menu items for configuring calculation
settings, such as the display format for
calculation results.

System Settings
Includes menu items for configuring calculator
operation settings, such as contrast adjustment.

Reset
Includes menu items for performing various types
of reset operations.
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Get Started
Displays the Get Started screen. For more
information, see "Calculator "Get Started"
Screen" (page 7).

Note

• Pressing  while the HOME screen is displayed will display the Get Started screen
instead of the SETTINGS menu.

• Depending on the screen displayed by the calculator app, pressing  may not
display the SETTINGS menu.

Changing Calculator Settings
1. Press , select a calculator app icon, and then press .
2. Press  to display the SETTINGS menu.

3. Use  and  to select Calc Settings or System Settings, and then
press .
• This displays a list of setting items included on the selected menu.

The screen here shows an example of what appears when [Calc
Settings] is selected.

• See "Items and Available Setting Options" (page 19) for the
setting items included for [Calc Settings] and [System Settings].

4. Use  and  to highlight the item whose setting you want to change,
and then press .
• This displays a list of setting options for the item you selected.

The screen here shows an example of what appears when [Input/
Output] is selected.

5. Use  and  to highlight the option you want, and then press .
6. After the setting is the way you want, press .
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Items and Available Setting Options
"◆" indicates the initial default setting.

Calc Settings > Input/Output

Specifies the format to be used by the calculator for expression input and
calculation result output.

MathI/MathO◆ Input: Natural Textbook; Output:
Format that includes a fraction, √ ,
and/or π*1

MathI/DecimalO
Input: Natural Textbook; Output:
Converted to decimal value

LineI/LineO
Input: Linear*2; Output: Decimal or
fraction

LineI/DecimalO
Input: Linear*2; Output: Converted
to decimal value

*1 Decimal output is applied when these formats cannot be output for
some reason.

*2 All calculations, including fractions and functions are input in a single
line. Same output format as that for models without Natural Textbook
Display (S-V.P.A.M. models, etc.)

Input/output format display examples:

MathI/MathO
(initial default setting)

MathI/DecimalO
(Number Format: Norm 1)

(Number Format: Norm 2)

LineI/LineO
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LineI/DecimalO
(Number Format: Norm 2)

Calc Settings > Angle Unit

Degree◆; Radian; Gradian
Specifies degree, radian or gradian as the angle unit for value input and
calculation result display.

Calc Settings > Number Format

Specifies the number of digits for display of a calculation result.
Fix: The value you specify (from 0 to 9) controls the number of decimal
places for displayed calculation results. Calculation results are rounded off
to the specified digit before being displayed.

Example: 1 ÷ 6
(Fix 3)

1 6 ( )*

Sci: The value you specify (from 1 to 10) controls the number of significant
digits for displayed calculation results. Calculation results are rounded off
to the specified digit before being displayed.

Example: 1 ÷ 6
(Sci 3)

1 6 ( )*

Norm: Displays calculation results in exponential format when they fall
within the ranges below.
Norm 1: 10-2 > |x|, |x| ≥ 1010, Norm 2◆: 10-9 > |x|, |x| ≥ 1010

Example: 1 ÷ 200
(Norm 1)

1 200 ( )*

(Norm 2)
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1 200 ( )*

* Pressing ( ) instead of  after inputting a calculation will display
the calculation result in decimal form.

Calc Settings > Fraction Result

Mixed Fraction; Improp Fraction◆
Specifies either mixed fraction or improper fraction for display of fractions
in calculation results.

Calc Settings > Complex Result

a+bi◆; r∠θ
Specifies either rectangular coordinates or polar coordinates for Complex
app calculation results.

Note

• An i indicator is displayed at the top of the screen while a+bi is selected for the
Complex Result setting. ∠ is displayed while r∠θ is selected.

Calc Settings > Decimal Mark

Dot◆; Comma
Specifies whether to display a dot or a comma for the calculation result
decimal mark. A dot is always displayed during input. When dot is selected
as the decimal mark, the separator for multiple results is a comma (,).
When comma is selected, the separator is a semicolon (;).

Calc Settings > Digit Separator

On◆; Off
Specifies whether or not a separator character should be used in
calculation results.

System Settings > Contrast

See "Adjusting Display Contrast" (page 12).
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System Settings > Auto Power Off

10 Min.◆; 60 Min.
Specify the amount of time until Auto Power Off is triggered.

System Settings > MultiLine Font

Normal Font◆; Small Font
Specifies the display font size when LineI/LineO or LineI/DecimalO is
selected for Input/Output. Up to four lines can be displayed while Normal
Font is selected, and up to six lines can be displayed with Small Font.

System Settings > QR Code

Specifies the version of the QR Code displayed when (QR) is
pressed.
Version 3: Indicates QR Code Version 3.
Version 11◆: Indicates QR Code Version 11.

Reset > Settings & Data

See "To initialize calculator settings" (page 22).

Reset > Variable Memory

See "Clearing the Contents of All Memories" (page 37).

Reset > Initialize All

See "Initializing the Calculator" (page 7).

Get Started

See "Calculator "Get Started" Screen" (page 7).

To initialize calculator settings

Important!

• The procedure below initializes all calculator settings, except for Contrast and Auto
Power Off. Also clears all data except for variable memory and Ans and PreAns data.
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1. Press , select a calculator app icon, and then press .
2. Press , and then select [Reset] > [Settings & Data] > [Yes].

• This displays the HOME screen.

Using the CATALOG Menu
Press  to display the CATALOG menu. This menu shows categories of
the commands, functions, and symbols in accordance with the calculator
app you are currently using and the current status (displayed screen or
current settings) of the app.

Example: CATALOG menu of the Calculate app

Note

• For information about how to input commands, functions, and symbols from the
CATALOG menu, see "Advanced Calculations" (page 46).

• For information about the commands, functions, and symbols specific to each
calculator app, refer to the calculator app descriptions in "Using Calculator Apps"
(page 65).

Using the TOOLS Menu
The TOOLS menu that appears when you press  includes menu items
for performing functions specific to each calculator app and for configuring
settings.

Example: TOOLS menu for the Calculate app

Examples: TOOLS menu for the Table app
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Note

• The menu items below are common to multiple calculator apps.
- Undo (See "Undo Operations" (page 27).)
- Verify ON, Verify OFF (See "Using Verify" (page 59).)
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Inputting Expressions and
Values

Basic Input Rules
When you press  the priority sequence of the input calculation will be
evaluated automatically and the result will appear on the display.

4 × sin 30 × (30 + 10 × 3) = 120

*1 Input of the closing parenthesis is required for sin and other functions
that include parentheses.

*2 These multiplication symbols (×) can be omitted.
*3 The closing parenthesis immediately before the  operation can be

omitted.

Moving the Cursor to the Beginning or End of an Input
Expression

While inputting an expression, you can press  to make the cursor
jump to the beginning of the expression or  to jump to the end of the
expression.

Input Expression and Calculation Result "More" Indicator (  ,
)

If you see a pointer (  or ) symbol on the right side of either an
input expression line or calculation result line, it means the displayed line
continues to the right. Use  and  to scroll the line left and right.
• When you see  at the right end of a calculation result line, you can

jump to the end of the result by pressing . To jump to the beginning of
a calculation result line, press .

• Note that if you want to scroll the input expression while both the  and
 indicators are displayed, you will need to press  or  first and

then use  and  to scroll.
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Parentheses Auto Complete

If you execute a calculation that includes both division and multiplication
operations in which a multiplication sign has been omitted, parentheses
will be inserted automatically as shown in the examples below.
- When a multiplication sign is omitted immediately before an open

parenthesis or after a closing parenthesis.
Example: 6 ÷ 2(1 + 2) → 6 ÷ (2(1 + 2))

- When a multiplication sign is omitted immediately before a variable, a
constant, etc.
Example: 6 ÷ 2π → 6 ÷ (2π)

Input Limit Indication

The cursor will change shape to  when there are 10 bytes or less of
allowed input remaining. If this happens, end calculation input and then
press .

Inputting an Expression Using
Natural Textbook Format (MathI/
MathO or MathI/DecimalO Only)
Expressions that include fractions and/or special functions such as √  can
be input in natural textbook format by using templates that appear when
certain keys are pressed, or when you input certain functions from the
CATALOG menu.

Example: 3 1
2  + 5 3

2
1. Press ( ).

• This inputs a mixed fraction template.

2. Input values into the integer, numerator, and denominator areas of the
template.

3 1 2
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3. Do the same to input the remainder of the expression.

( )5 3 2

Note

• While the input cursor is located within the input area of a template (mixed fractions,
summation (Σ) and product (Π)), pressing  jumps to the position immediately
following (to the right of) the template, while pressing  jumps to the position
immediately before (to the left of) it.

• You can always tell the current location of the cursor within a template because the
blank framed area or the characters where it is located will be dark black. Everything
else in the calculation expression will be dark gray.

Undo Operations
To undo the last key operation, press , select [Undo], and then press

.
To redo a key operation you have just undone, press , select [Undo],
and then press  again.

Using Values and Expressions as Arguments

Example: To input 1 + 7
6  and then change it to 1 + 

1 7 6 (INS)

Pressing (INS) in the above example causes 7
6  to be the argument

of the function input by the next key operation (√ ).

Overwrite Input Mode (LineI/LineO or
LineI/DecimalO Only)
In the overwrite mode, text you input replaces the text at the current
cursor location. You can toggle between the insert and overwrite modes
by performing the operation: (INS). The cursor appears as " " in the
insert mode and as " " in the overwrite mode.
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Basic Calculations

Arithmetic Calculations
Use the , , , and  keys to perform arithmetic calculations.

Example: 7 × 8 - 4 × 5 = 36

7 8 4 5

Fraction Calculations
Note that the input method for fractions depends on the current Input/
Output setting on the SETTINGS menu.

To input 7
3  (improper fraction)

(Input/Output: MathI/MathO or MathI/DecimalO)

7 3 or 7 3 7
3

(Input/Output: LineI/LineO or LineI/DecimalO)

7 3

(a) Numerator, (b) Denominator

To input 2 1
3  (mixed fraction)

(Input/Output: MathI/MathO or MathI/DecimalO)

( )2 1 3 2 1
3

(Input/Output: LineI/LineO or LineI/DecimalO)
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2 1 3

(a) Numerator, (b) Denominator, (c) Integer Part

Example: 2
3  + 1 1

2  = 13
6

(Input/Output: MathI/MathO)

2 3 ( )1 1 2

(Input/Output: LineI/LineO)

2 3 1 1 2

Note

• Fractions in calculation results are displayed after being reduced to their lowest terms.

To convert a calculation result format to improper fraction or mixed
fraction, press . For more information, see "Improper Fraction and
Mixed Fraction Conversion" (page 43).

Fraction Format Calculation Results

A calculation result whose total number of mixed fraction number of digits
(including integer, numerator, denominator, and separator symbol ) is
greater than 10 cannot be displayed using fraction format. In this case, the
calculation result is displayed as a decimal value.

Example 1: 1 1 123456 = 123457 123456

(Input/Output: LineI/LineO)

1 1 123456

Since the total number of digits of the value 1 1 123456 is 10, the result
is displayed as a fraction value.

Example 2: 1 1 1234567 (= 1234568 1234567) = 1.00000081
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(Input/Output: LineI/LineO)

1 1 1234567

Since the total number of digits of the value 1 1 1234567 is 11, the
result is displayed as a decimal value.

Note

• Mixing fractions and decimal values in a calculation while something other than MathI/
MathO is selected will cause the result to be displayed as a decimal value.

Powers, Power Roots, and
Reciprocals
Use the keys below to input power functions, power root functions, and
reciprocal function.
Power functions: (square), (nth power)
Power root functions: (square root), ( ) (nth root)
Reciprocal function:  ( )

Example 1: (52)3 = 15625

5 3

Example 2: (1 + 1)2+2 = 16

1 1 2 2

Example 3: √2 × 3 = 3√2 = 4.242640687...
(Input/Output: MathI/MathO)

2 3

(Input/Output: LineI/LineO)
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2 3

Example 4: 5√32 = 2
(Input/Output: MathI/MathO)

( ) 5 32

(Input/Output: LineI/LineO)

5 ( ) 32

Example 5: 10-1 = 1
10

(Input/Output: MathI/MathO)

10 ( )

 Key (Power of 10)

Pressing the  key is the same as pressing . Both operations
input "×10 " (MathI/MathO or MathI/DecimalO) or "×10^(" (LineI/LineO or
LineI/DecimalO).

Example: 1.23 × 103 = 1230

1 23 3

√  Form Calculation Range

The allowable display ranges of the √  form calculation result are shown
below.

± a√b, ± d ± a√b, ± a√b
c  ± d√e

f
1 ≤ a < 100, 1 < b < 1000, 1 ≤ c < 100
0 ≤ d < 100, 0 ≤ e < 1000, 1 ≤ f < 100
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Example:
• 10√2 + 15 × 3√3 = 45√3 + 10√2 ... Displayed in √  form
• 99√999 (= 297√111) = 3129.089165 ... Displayed as a decimal value

Pi, Natural Logarithm Base e

Pi
Input π by pressing (π).
π is displayed as 3.141592654, but π = 3.1415926535897932384626 is
used for internal calculations.

Natural Logarithm Base e
Input e by pressing (e).
Natural Logarithm Base e is displayed as 2.718281828, but e =
2.7182818284590452353602 is used for internal calculations.

Calculation History and Replay

Calculation History
An  and/or  at the top of the screen indicates more calculation history
content above and/or below. You can scroll through calculation history
contents using  and .

Apps that support calculation history:
Calculate, Complex

Example
2 + 2 = 4

2 2

3 + 3 = 6

3 3

(Scrolls back.)

32



Note

• Calculation history data is all cleared whenever you press  or , when
you change the Input/Output setting, or whenever you perform a Reset operation
("Settings & Data" or "Initialize All").

Replay
While a calculation result is on the display, you can press ,  or  to
edit the expression you used for the previous calculation.

Example
4 × 3 + 2 = 14

4 3 2

4 × 3 - 7 = 5

(Continuing)  7

Note

• If  (left) or  (right) is displayed on either end or both ends of a calculation result
line, you can use  and  to scroll the line left and right. If this happens, press 
or  first, and then use  and  to edit the expression.

Using Memory Functions

Answer Memory (Ans) / Previous Answer Memory
(PreAns)

The last calculation result obtained is stored in Ans (answer) memory.
The calculation result obtained prior to the last one is stored in PreAns
(previous answer) memory. Displaying the result of a new calculation will
move current Ans memory contents to PreAns memory and store the new
calculation results in Ans memory.

Note

• PreAns memory can be used only in the Calculate app.
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• PreAns memory contents are cleared whenever you switch to another app besides the
Calculate app.

Using Ans Memory to Perform a Series of Calculations

Example: To divide the result of 3 × 4 by 30

3 4

(Continuing)  30

Inputting Ans Memory Contents into an Expression

Example: To perform the calculations shown below:

123 456

(Continuing)  789

Using PreAns Memory

Example: For Tk+2 = Tk+1 + Tk (Fibonacci sequence), determine the
sequence from T1 to T5. Note however, that T1 = 1 and T2 = 1.
T1 = 1

1

(Ans = T1 = 1)

T2 = 1

1

(Ans = T2 = 1, PreAns = T1 = 1)

T3 = T2 + T1 = 1 + 1

(PreAns)

(Ans = T3 = 2, PreAns = T2 = 1)

T4 = T3 + T2 = 2 + 1
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(Ans = T4 = 3, PreAns = T3 = 2)

T5 = T4 + T3 = 3 + 2

Result: The sequence is {1, 1, 2, 3, 5}.

Variables (A, B, C, D, E, F, x, y, z)
You can store values to variables and use the variables in calculations.

Variable List Screen

Pressing  displays a screen that shows the values currently stored to
variables A, B, C, D, E, F, x, y, and z. On this screen, values are always
displayed using the "Norm 1" Number Format. To close the screen, press

 or .

Example 1: To store the result of 3 + 5 to variable A
1. Execute the calculation.

3 5

2. Press , and then select [A=] > [Store].
• This stores the result of 3 + 5 (which is 8) to variable A.

3. Press .

Example 2: To change the contents of variable A to 1
1. Press , and then highlight [A=].
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2. Press .
• This displays the editing screen with 1 entered.

3. Press .

Note

• In place of the operation in step 2 above, you can press  and then select [Edit].
This displays the editing screen with nothing input. Input the value you want and then
press .

• If a lock ( ) icon appears when you highlight a variable on the variable list screen, it
means the highlighted variable cannot be edited.

Example 3: To recall the contents of variable A
(Continuing from step 2 of Example 1)
1. Press , and then select [A=] > [Recall].

• This inputs "A".

2. Press .
• This recalls the value of variable A.

Example 4: To multiply the contents of variable A by 10
(Continuing from step 2 of Example 1)

(A)* 10

* Input a variable as shown here: press  and then press the key that
corresponds to the desired variable name. To input x as the variable
name, you can press (x) or .
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Clearing the Contents of All Memories
Ans memory and variable contents are retained even if you press ,
change the calculator app, or turn off the calculator.
PreAns memory contents are retained even if you press  and turn off
the calculator without exiting the Calculate app.
Perform the procedure below when you want to clear the contents of all
memories.
1. Press , select a calculator app icon, and then press .
2. Press , and then select [Reset] > [Variable Memory] > [Yes].
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Changing Calculation Result
Format

Using the FORMAT Menu
You can use the FORMAT menu that appears when you press  to
convert a displayed calculation result to various formats.

FORMAT Menu List

This menu item: Converts to this format:

Standard
Standard (Includes fraction, π,
√  formats.)

Decimal Decimal

Prime Factor Prime factorization

Recurring Decimal Recurring decimal

Rectangular Coord Rectangular coordinates

Polar Coord Polar coordinates

Improper Fraction Improper fraction

Mixed Fraction Mixed fraction

ENG Notation
Engineering notation (a×10n format, n
= exponent divisible by 3)

Sexagesimal
Degree, minute, second
(Sexagesimal)
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Note

• The menu items that appear when  is pressed depend on the currently displayed
calculation result. Also, if a calculation result that cannot be converted is displayed, the
menu will not appear when you press .

Conversion Sample Operation

Example: 3 ÷ 2 = 3
2  = 1.5 = 1 1

2
In this example, we will convert a calculation result displayed as an
improper fraction to a decimal value and then to a mixed fraction. Finally,
we will cancel the conversion and go back to the original calculation result.
(Input/Output: MathI/MathO, Fraction Result: Improp Fraction)

1. Execute the calculation 3 ÷ 2.

3 2

2. To convert the calculation result to a decimal value, press , select
[Decimal], and then press .

3. To convert the calculation result to a mixed fraction, press , select
[Mixed Fraction], and then press .

4. To cancel conversion, press .
• This displays the original calculation result from step 1.

Standard and Decimal Conversion
Standard is a format that displays a calculation result in a form that
includes a fraction, √ , or π when possible. Decimal is a format that
displays the calculation result as a decimal value.
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Note

• Conversion to Standard format that includes √  or π is possible when MathI/MathO or
MathI/DecimalO is selected for the Input/Output setting on the SETTINGS menu.

You can use the operation below to convert a calculation result to the
Standard or Decimal format.

Example: π ÷ 6 = 1
6  π = 0.5235987756 (Input/Output: MathI/MathO)

(π) 6

(Select [Decimal].)

(Converts to a decimal value.)

(Coverts to Standard format.)

Important!

• With certain calculation results, selecting [Standard] on the FORMAT menu will not
convert the displayed value.

To obtain a decimal value calculation result while MathI/MathO
or LineI/LineO is selected

Press ( ) instead of  after inputting a calculation.

Prime Factorization
In the Calculate app, a positive integer no more than 10 digits long can be
factored to prime factors.
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Example: To perform prime factorization on 1014

1014

 – [Prime Factor]

Note

• The types of values described below cannot be factored, even if they have 10 or fewer
digits.
- One of the prime factors of the value is 1,018,081 or greater.
- Two or more of the prime factors of the value have more than three digits.

• The part that cannot be factored is enclosed in parentheses on the display.
Example: 2036162 = 2 × (1018081)*

*1018081 = 10092

2036162
 – [Prime Factor]

Recurring Decimal Conversion
(Recurring Decimal Calculations)
Your calculator lets you convert a calculation result to recurring decimal
format in the Calculate app when possible. It also makes it possible for you
to input a recurring decimal value and perform a calculation.

Converting a Calculation Result to a Recurring
Decimal Value

To convert a calculation result to a recurring decimal value, press , and
then select [Recurring Decimal] from the FORMAT menu that appears.
For the actual operation, see "Recurring Decimal Calculation Example"
(page 42).

Inputting a Recurring Decimal
To input a recurring decimal value, use the CATALOG menu item shown
below.

 – [Numeric Calc] > [Recurring Decimal]
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For the actual operation, see "Recurring Decimal Calculation Example"
(page 42).

Important!

• If the value starts with an integer part (like: 12.3123123...), do not include the integer
part when inputting the period (12.312).

• Recurring decimal input is possible only when MathI/MathO or MathI/DecimalO is
selected for Input/Output on the SETTINGS menu.

Recurring Decimal Calculation Example
To calculate 3.021 + 0.312 (Input/Output: MathI/MathO)
1. Use the following operation to input the calculation expression.

3  – [Numeric Calc] >
[Recurring Decimal] 021

0  – [Numeric Calc] >
[Recurring Decimal] 312

• This displays the calculation result as a fraction.

2. Press , and then select [Recurring Decimal].
• This changes the result format to recurring decimal.

• To return the calculation result to a fraction, select  – [Standard].

Note

• Only a calculation result that satisfies the conditions below can be displayed as a
recurring decimal.
- The total number of digits used in the mixed fraction (including integer, numerator,

denominator, and separator symbol) must be no more than 10.
- The data size of the value when displayed as a recurring decimal must be no larger

than 99 bytes, calculated as: [number of digits (1 byte each)] + [1 byte for the
decimal point] + [3 bytes for recurring decimal management code]. For example, the
data size of 0.123 would be 4 bytes for digits, 1 byte for the decimal point, and 3
bytes for recurring decimal management code, for a total of 8 bytes.
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Rectangular and Polar Coordinate
Conversion
You can convert a complex number calculation result to rectangular
coordinates (  – [Rectangular Coord]) or polar coordinates (  – [Polar
Coord]). This conversion operation can be performed while a Complex app
calculation result is displayed.

For an actual sample conversion operation, see the section below.
"Converting a Complex Number Calculation Result to Rectangular or
Polar Coordinates" (page 94)

Improper Fraction and Mixed
Fraction Conversion
You can convert the currently displayed fraction or decimal value (decimal
value that is convertible to a fraction by this calculator) calculation result to
a mixed fraction or an improper fraction.

Example 1: 13
4  = 3 1

4
(Input/Output: MathI/MathO, Fraction Result: Improp Fraction)

13 4

 – [Mixed Fraction]

 – [Improper Fraction]

Example 2: 3.25 = 13
4  = 3 1

4  (Input/Output: LineI/LineO)

3 25

 – [Improper Fraction]

 – [Mixed Fraction]

Engineering Notation
You can convert the exponent part of a displayed calculation result value
to a power of ten that is a multiple of 3, and displays the result.
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Example: Transform the value 1234 to engineering notation, shifting the
decimal mark to the right, and then to the left.
1. Input 1234, and then press .

2. Perform the operation below to enter the ENG Conversion Mode.

 – [ENG Notation]

• Entering the ENG Conversion Mode converts the calculation result to
engineering notation and causes  to appear to its right.

• In the ENG Conversion Mode, you can use  and  to shift the
decimal point of the mantissa.

3. To exit the ENG Conversion Mode, press .
• This exits the ENG Conversion Mode and causes  to disappear from

the display.

• You can also exit the ENG Conversion Mode by pressing  or .

Note

• Normal calculations are not possible while in the ENG Conversion Mode. To start a
new calculation, exit the ENG Conversion Mode.
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Sexagesimal Conversion (Degree,
Minute, Second Calculations)
You can convert a decimal value calculation result to a sexagesimal value.

Converting a Decimal Value Calculation Result to a
Sexagesimal Value

Example: 1.25 = 1°15’0”

1 25

 – [Sexagesimal]

Inputting and Calculating with a Sexagesimal
Value

In addition to converting a displayed value to a sexagesimal value, you
can also input sexagesimal values and use them in calculations.
The syntax below is for inputting a sexagesimal value:

{degrees} ( ) {minutes} ( ) {seconds} ( )
Note that you must always input something for the degrees and minutes,
even if they are zero.

Example: To perform the calculation 2°20’30” + 9’30”. Next, convert the
calculation result to a decimal value.

2 ( )20 ( )30 ( )
0 ( )9 ( )30 ( )

(Convert to a decimal value.)
 – [Decimal]

(Return to sexagesimal display.)
 – [Sexagesimal]
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Advanced Calculations
This section describes commands, functions, and symbols that are
common to all of the calculator apps. The order used here to present
commands, functions, and symbols is the same order in which they are
displayed on the CATALOG menu that appears when you press .

Note

• There are also calculator app-specific CATALOG menu items, which are not shown
here. See the chapter for each calculator app for more information about app-specific
menu items.

• Depending on the calculator app you are using and the screen displayed by the
calculator app, you may not be able to input some commands, functions, or symbols.
Commands, functions, and symbols that cannot be input do not appear on the
CATALOG menu.

Function Analysis
This section explains commands and functions that you can input after
performing the operation:  – [Func Analysis].

Summation(Σ)
With Σ(, you can obtain the sum of an input f(x) expression for a specific
range.

Note

• This function can be used with any of the following calculator apps: Calculate,
Statistics, Distribution, Table, Vector.

Input Syntax

The input syntax depends on the Input/Output setting on the SETTINGS
menu, as shown in the table below.

Input/Output setting Input Syntax

MathI/MathO or MathI/DecimalO
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LineI/LineO or LineI/DecimalO

* a and b are integers that can be specified within the range of -1 × 1010 <
a ≤ b < 1 × 1010.

Σ Calculation Example

 (x + 1) = 20

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Summation(Σ)]
1 1 5

(Input/Output: LineI/LineO)

 – [Func Analysis] > [Summation(Σ)]
1 (,)1 (,)5

Product(Π)
With ∏(, you can obtain the product of an input f(x) expression for a
specific range.

Note

• This function can be used with any of the following calculator apps: Calculate,
Statistics, Distribution, Table, Vector.

Input Syntax

The input syntax depends on the Input/Output setting on the SETTINGS
menu, as shown in the table below.

Input/Output setting Input Syntax

MathI/MathO or MathI/DecimalO

LineI/LineO or LineI/DecimalO Π(f(x), a, b)*

* a and b are integers that can be specified within the range of a < 1 ×
1010, b < 1 × 1010, a ≤ b.
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∏ Calculation Example

 (x + 1) = 720

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Product(Π)]
1 1 5

(Input/Output: LineI/LineO)

 – [Func Analysis] > [Product(Π)]
1 (,)1 (,)5

Logarithm(logab), Logarithm(log)
Use (log) or  – [Func Analysis] > [Logarithm(log)] to input logab as
log (a, b). Base 10 is the initial default setting if you do not input anything
for a.

Example 1: log101000 = log 1000 = 3

(log)1000

Example 2: log216 = 4

(log)2 (,)16

The  key (or  – [Func Analysis] > [Logarithm(logab)]) also can be
used for input, but only while MathI/MathO or MathI/DecimalO is selected
for Input/Output on the SETTINGS menu. In this case, you must input a
value for the base.

Example 3: log216 = 4

2 16
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Natural Logarithm
Use (ln) or  – [Func Analysis] > [Natural Logarithm] to input "ln".

Example: ln 90 (= loge90) = 4.49980967

(ln)90

Probability
This section explains commands and functions that you can input after
performing the operation:  – [Probability].

%
Inputting a value followed by % command causes the input value to
become a percent.

Note

• You cannot input % with the Complex app.

Example 1: 150 × 20% = 30

150 20
 – [Probability] > [%]

Example 2: Calculate what percentage of 880 is 660. (75%)

660 880
 – [Probability] > [%]

Example 3: Discount 3500 by 25%. (2625)

3500 3500 25
 – [Probability] > [%]

Factorial(!)
This function obtains the factorials of a value that is zero or a positive
integer.
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Example: (5 + 3)! = 40320

5 3
 – [Probability] > [Factorial(!)]

Permutation(P), Combination(C)
Permutation (nPr) and combination (nCr) functions.

Example: To determine the number of permutations and combinations
possible when selecting four people from a group of 10

Permutations:

10
 – [Probability] > [Permutation(P)]

4

Combinations:

10
 – [Probability] > [Combination(C)]

4

Random Number
This function generates a pseudo random number in the range of 0.000 to
0.999. The result is displayed as a fraction when MathI/MathO is selected
for Input/Output on the SETTINGS menu.

Example: To obtain random three-digit integers

1000
 – [Probability] > [Random Number]

(The result differs with each execution.)

Random Integer
This function generates a pseudo random integer between a specified
start value and end value.

Example: To generate random integers in the range of 1 to 6

 – [Probability] > [Random Integer]
1 (,)6
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(The result differs with each execution.)

Numeric Calculations
This section explains commands and functions that you can input after
performing the operation:  – [Numeric Calc].

GCD, LCM
GCD determines the greatest common divisor of two values, while LCM
determines the least common multiple.

Example 1: To determine the greatest common divisor of 28 and 35

 – [Numeric Calc] > [GCD]
28 (,)35

Example 2: To determine the least common multiple of 9 and 15

 – [Numeric Calc] > [LCM]
9 (,)15

Absolute Value
When you are performing a real number calculation, this function simply
obtains the absolute value.

Example: |2 - 7| = Abs(2 - 7) = 5
(Input/Output: MathI/MathO)

 – [Numeric Calc] > [Absolute Value]
2 7

(Input/Output: LineI/LineO)

 – [Numeric Calc] > [Absolute Value]
2 7

Recurring Decimal
You can use the menu item below to input a recurring decimal.

 – [Numeric Calc] > [Recurring Decimal]
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For details, see "Recurring Decimal Conversion (Recurring Decimal
Calculations)" (page 41).

Round Off
Using the Round Off function (Rnd) causes decimal fraction values of the
argument to be rounded in accordance with the current Number Format
setting. For example, the internal and displayed result of Rnd(10 ÷ 3) is
3.333 when the Number Format setting is Fix 3. Using the Norm 1 or Norm
2 setting cause the argument to be rounded off at the 11th digit of the
mantissa part.

Example: To perform the following calculations when Fix 3 is selected for
the number of display digits: 10 ÷ 3 × 3 and Rnd(10 ÷ 3) × 3
(Input/Output: MathI/DecimalO, Number Format: Fix 3)

10 3 3

 – [Numeric Calc] > [Round Off]
10 3 3

Angle Unit, Polar/Rectangular
Coordinate, Sexagesimal
This section explains commands, functions, and symbols that you can
input after performing the operation:  – [Angle/Coord/Sexa].

Degrees, Radians, Gradians
These functions specify the angle unit.
° specifies degree, r radian, and g gradian.
You can input each function using the menu items below.

 – [Angle/Coord/Sexa] > [Degrees]
 – [Angle/Coord/Sexa] > [Radians]
 – [Angle/Coord/Sexa] > [Gradians]

Example: π/2 radians = 90° (Angle Unit: Degree)

(π) 2
 – [Angle/Coord/Sexa] > [Radians]

52



Rect to Polar, Polar to Rect
"Pol(" converts rectangular coordinates to polar coordinates, while "Rec("
converts polar coordinates to rectangular coordinates.

• Specify the Angle Unit on the SETTINGS menu before performing
calculations.

• The calculation result for r and θ and for x and y are each stored
respectively to variables x and y.

• Calculation result θ is displayed in the range of -180° < θ ≤ 180°.

Note

• Pol( and Rec( can be used on the calculation screen of the calculator apps below.•
Calculate*, Statistics
* When Verify is disabled (Verify OFF).

Example 1: To convert rectangular coordinates (√2, √2) to polar
coordinates (Input/Output: MathI/MathO, Angle Unit: Degree)

 – [Angle/Coord/Sexa] > [Rect to Polar]
2 (,) 2

Example 2: To convert polar coordinates (√2, 45°) to rectangular
coordinates (Input/Output: MathI/MathO, Angle Unit: Degree)

 – [Angle/Coord/Sexa] > [Polar to Rect]
2 (,) 45

Degrees, Minutes, Seconds
You can use the keys or the menu item below to input the sexagesimal
symbol ( ).

( )
 – [Angle/Coord/Sexa] > [Degs Mins Secs]

For details, see "Sexagesimal Conversion (Degree, Minute, Second
Calculations)" (page 45).
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Hyperbolic, Trigonometric
This section explains hyperbolic and trigonometric functions.

Hyperbolic Functions
Hyperbolic functions can be input using the menu items below.

 – [Hyperbolic/Trig] > [sinh], [cosh], [tanh], [sinh-1], [cosh-1], or [tanh-1]

The angle unit setting does not affect calculations.

Example: sinh 1 = 1.175201194

 – [Hyperbolic/Trig] > [sinh] 1

Trigonometric Functions
Trigonometric functions can be input using the keys or menu items below.

Key Menu Item

 – [Hyperbolic/Trig] > [sin]

 – [Hyperbolic/Trig] > [cos]

 – [Hyperbolic/Trig] > [tan]

(sin-1)  – [Hyperbolic/Trig] > [sin-1]

(cos-1)  – [Hyperbolic/Trig] > [cos-1]

(tan-1)  – [Hyperbolic/Trig] > [tan-1]

Specify the Angle Unit on the SETTINGS menu before performing
calculations.

Example: sin 30 = 1
2  (Angle Unit: Degree)

30
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*1

*2

*3

Others
Functions and symbols that can be input with the calculator keys can also
be input using the [Other] menu. Use  – [Other] to display the function
and symbol menu. For example, to input Ans, you could either press  or
perform the following operation:  – [Other] > [Ans].
The table below shows the [Other] menu item that corresponds to each
key operation.

Menu Item Key

Ans

PreAns (PreAns)

π (π)

e (e)

√ (

x√ ( ( )

-1 ( )

2

^(

- ((-))

, (,)

(

)

*1 Reciprocal
*2 Square
*3 Minus sign
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Registering and Using Defining
Equations for f(x) and g(x)

Registering and Using Defining
Equations for f(x) and g(x)
Your calculator includes "f(" and "g(" functions that you can use after
registering defining equations for them. For example, after registering f(x)
= x2 + 1 as a defining equation for the "f(" function, you can calculate f(0) =
1 and f(5) = 26.
Pressing  displays a menu for registering the defining equation of f(x) or
g(x), and for inputting "f(" or "g(".

Note

• The defining equations of f(x) and g(x) are also used by f(x) and g(x) in the Table app.
For information about the Table app, see "Creating a Number Table" (page 86).

Registering a Defining Equation
Example 1: To register f(x) = x2 + 1
1. Press , select the Calculate app icon, and then press .
2. Press , and then select [Define  f(x)].

• This displays the f(x) equation registration screen.

3. Input x2 + 1.

1

4. Press .
• This registers the expression you input, and the screen that was

shown before you pressed  in step 2 of this procedure re-appears.

Note

• A defining equation can be registered from any calculator app except Distribution.
However, depending on the screen displayed by the calculator app (for example, if a
menu screen is displayed), the menu may not appear when you press .
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Performing a Calculation by Assigning a Value to
the Registered Defining Equation

Example 2: To assign the value x = 3 to f(x), which you registered in
Example 1
(Continuing from Example 1)
1. Press , and then select [f(x)].

• This inputs "f(".

2. Assign a value of 3 and then execute the calculation.

3

Registering a Composite Function
Example 3: To insert f(x) defined in Example 1 into g(x) in order to register
g(x) = f(x) × 2 - x
(Continuing from Example 1)
1. Press , and then select [Define  g(x)].

• This displays the g(x) equation registration screen.

2. Input f(x) × 2 - x.

* 2

* Pressing  while the g(x) equation registration screen is displayed,
the only menu item that appears is [f(x)]. In the same way, pressing 
while the f(x) equation registration screen is displayed, the only menu
item that appears is [g(x)].

3. Press .
• This registers the equation you input and returns to the screen

displayed before you started this operation with step 1.

Note

• The operation for assigning a value to x of g(x) and calculating the result is the same
as that under "Performing a Calculation by Assigning a Value to the Registered
Defining Equation" (page 57). However, note that instead of selecting [f(x)] in step 1,
you should select [g(x)].

• In the operation of Example 3, you input f(x) into the defining equation of g(x).
Conversely, you can also input g(x) into the f(x) defining equation. However, do not
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have g(x) input into f(x), and f(x) input into g(x) at the same time. If you do, a Circular
ERROR will occur when you perform a calculation using f(x) or g(x).

Data Retention
Performing any one of the operations below causes the defining equations
registered to f(x) and g(x) to be deleted.

• Using the SETTINGS menu to switch the Input/Output setting
between MathI*1 and LineI*2.
*1 MathI/MathO or MathI/DecimalO
*2 LineI/LineO or LineI/DecimalO

• Executing  – [Reset] > [Settings & Data] or  – [Reset] > [Initialize
All]
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Using Verify

Verify Overview
Verify determines the authenticity of an input equality or inequality.

Verify is available with the following calculator apps.
Calculate, Table, Complex

Note

• The target and required procedure for a Verify operation depend on the calculator app
where it is being used. For details, see the sections below.
Using Verify with the Calculate App (page 60)
Using Verify with the Table App (page 89)
Using Verify with the Complex App (page 94)

Enabling and Disabling Verify
To use Verify, you first need to enable it by selecting [Verify ON] on the
calculator app’s TOOLS menu.

Important!

• Switching Verify between enabled and disabled in the Calculate or Complex app will
clear the entire calculation history.

• While Verify is enabled, a calculator app can be used only for Verify operations. It
cannot be used for normal calculations. Disable Verify when you are not using it.

Note

• Verify is normally disabled after you launch a calculator app. However, if you return to
the HOME screen from a calculator app after you enable Verify and then launch the
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same calculator app again before launching a different calculator app, Verify will still
be enabled.

To enable Verify

1. Press , select the icon of the calculator app you want to launch, and
then press .
• Select a calculator app that can use Verify.

2. Press  to display the TOOLS menu.
• Depending on the screen displayed by a calculator app, a menu may

not appear when you press .
3. Select [Verify ON], and then press .

• This returns to the screen displayed before you pressed . At this
time, an  indicator appears at the top of the screen to indicate that
Verify is enabled.

To disable Verify

1. Press  to display the TOOLS menu.
2. Select [Verify OFF], and then press .

• This returns to the screen displayed before you pressed , and the
 indicator disappears from the top of the screen.

Note

• Verify is disabled whenever you perform any one of the following operations.
- Pressing 
- Pressing  (or ) to return to the HOME screen from the current calculator app

and then launching another calculator app
- Executing  – [Reset] > [Settings & Data] or  – [Reset] > [Initialize All]

Using Verify with the Calculate App
After enabling Verify in the Calculate app, you can determine if an
equation or inequality is true. "True" appears on the display if the equation
or inequality you input on the calculator is true, while "False" appears if it is
false.

Verify Sample Operation
Enable Verify in a Calculate app before performing the operation below.
For information about how to enable Verify, see "To enable Verify" (page
60).
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Example 1: To verify whether 4√9 = 12 is true or false

4 9
 – [Verify] > [＝]*

12

* You can select the equality symbol or inequality symbol from the menu
that appears when you press  and then select [Verify].

Example 2: To verify whether 0 < ( 8
9  )2  -  8

9   is true or false

0  – [Verify] > [＜]
8 9 8 9

Verifiable Expressions
You can input the following expressions for verification.
• Equalities or inequalities that include one relational operator

4 = √16, 4 ≠ 3, π > 3, 1 + 2 ≤ 5, (3 × 6) < (2 + 6) × 2, etc.
• Equalities or inequalities that include multiple relational operators

1 ≤ 1 < 1 + 1, 3 < π < 4, 22 = 2 + 2 = 4, 2 + 3 = 5 ≠ 2 + 5 = 8, etc.

Expression Input Precautions

• The following types of expressions cause a Syntax ERROR and cannot
be verified.
- An expression in which multiple relational operators that are not
oriented in the same direction (Example: 5 ≤ 6 ≥ 4)
- An expression that contains two of the following operators in any
combination (Example: 4 < 6 ≠ 8)

• Certain expressions that do not correspond to those described above
may also produce a Syntax ERROR and cannot be verified.

Performing a Sequential Verification Operation on
the Right Side of an Expression

When the result of an equality or inequality true-false verification that
includes a relational operator is displayed, selecting a relational operator
from the CATALOG menu inputs the right side of the expression being
verified as the next line. This capability can be used to perform sequential
true-false verification of an equality or inequality.

Example: Perform continuous true-false judgment of (x + 1)(x + 5) = x2 + x
+ 5x + 5 and x2 + x + 5x + 5 = x2 + 6x + 5
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1 5
 – [Verify] > [＝]

5 5

 – [Verify] > [＝]

6 5

Note

• The verification result will cause 1 to be stored to Ans memory when True and 0 when
False.

• When Verify is enabled (Verify ON), the calculator performs a mathematical operation
on the input expression and then displays True or False based on the result. Because
of this, calculation error can occur or a mathematically correct result may not be
able to be displayed when the input calculation expression includes calculation that
approaches the singular point or inflection point of a function, or when the input
expression contains multiple calculation operations. Also, the solution displayed when
Verify is disabled (Verify OFF) may not be judged as True because the result may
differ from internal data due to rounding and the limit on displayed digits. This also
applies to apps other than the Calculate app.
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Using QR Code Functions

Using QR Code Functions
Your calculator can display QR Code symbols that can be read by a smart
device.

Important!

• The operations in this section assume that the smart device being used has a QR
Code reader that can read multiple QR Code symbols, and it can connect to the
Internet.

• Scanning a QR Code displayed by this calculator with a smart device will cause the
smart device to access the CASIO website.

Note

• QR Code appears on the display whenever you press (QR) while any one of
the screens below is displayed.
- HOME screen
- SETTINGS menu screen
- Error screens
- Calculation result screens in any calculator app
- Table screens in any calculator app
For details, visit the CASIO website (https://wes.casio.com).

Displaying a QR Code
Example: To display the QR Code for a calculation result in the
calculator’s Calculate app and scan it with a smart device
1. In the Calculate app, perform some calculation.
2. Press (QR) to display the QR Code.

• The numbers in the lower right corner of the display show the current
QR Code number and the total number of QR Code symbols. To
display the next QR Code, press  or .

Note

• To return to a previous QR Code, press  or  as many times as required to
scroll forward until it appears.

3. Use a smart device to scan the QR Code on the calculator display.
• For information about how to scan a QR Code, refer to the user

documentation of the QR Code reader you are using.
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If You Experience Difficulty Scanning a QR Code
While the QR Code is displayed, use  and  to adjust the display
contrast of the QR Code. This contrast adjustment affects QR Code
displays only.

Important!

• Depending on the smart device and/or QR Code reader app being used, you may
experience problems scanning the QR Code symbols produced by this calculator.

• When the "QR Code" setting on the SETTINGS menu is "Version 3", the calculator
apps that can display QR Code symbols are limited. If you try to display a QR Code in
an app that does not support QR Code display, the message "Not Supported (Version
3)" will appear. However, the QR Code produced by this setting is easier to scan with a
smart device.

• For more information, visit the CASIO website (https://wes.casio.com).
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Using Calculator Apps

Statistical Calculations
The Statistics app calculates various statistical values based on single-
variable (x) or paired-variable (x, y) data.

General Procedure for Performing a Statistical
Calculation

1. Press , select the Statistics app icon, and then press .
2. On the menu that appears, select [1-Variable] (single-variable) or [2-

Variable] (paired-variable), and then press .
• This displays the Statistics Editor.

Single-variable

Paired-variable

3. Display the Freq (frequency) column as needed.
• For details, see "Freq (Frequency) Column" (page 66).

4. Input data.
• For details, see "Inputting Data with Statistics Editor" (page 66).

5. After you finish inputting data, press .
• This causes the menu below to appear.

Single-variable
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Paired-variable

6. Select the menu item for the operation you want to perform.
• Select [1-Var Results], [2-Var Results], or [Reg Results] to see a list

of calculation results based on the data you entered. For details, see
"Displaying Statistical Calculation Results" (page 69).

• To display a statistical calculation screen for performing calculations
based on the input data, select [Statistics Calc]. For details, see
"Using Statistical Calculation Screen" (page 73).

Note

• To return to the Statistics Editor from a statistical calculation screen, press  and
then .

Inputting Data with Statistics Editor
Statistics Editor displays one, two, or three columns: single-variable
(x), single-variable and frequency (x, Freq), paired-variable (x, y), paired-
variable and frequency (x, y, Freq). The number of data rows that can be
input depends on the number of columns: 160 rows for one column, 80
rows for two columns, 53 rows for three columns.

Important!

• All data currently input in the Statistics Editor is deleted whenever you perform any of
the operations below.
- Switching the statistical calculation type between single-variable and paired-variable
- Changing the Frequency setting on the TOOLS menu

• Statistical calculations can take considerable time when there are a large number of
data items.

Freq (Frequency) Column

If you turn on the Frequency setting on the TOOLS menu, a column
labeled "Freq" will also be included on the Statistics Editor. You can use
the Freq column to specify the frequency (the number of times the same
sample appears in the data group) of each sample value.
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Single-variable

Paired-variable

To display the Freq column
1. While the Statistics Editor is displayed, press  and then select

[Frequency] > [On].
2. Press  to return to the Statistics Editor.

To hide the Freq column
1. While the Statistics Editor is displayed, press  and then select

[Frequency] > [Off].
2. Press  to return to the Statistics Editor.

Rules for Inputting Sample Data on the Statistics Editor

Data you input is inserted into the cell where the cursor is located. Use the
cursor keys to move the cursor between cells.

   Cursor

After inputting a value, press . This registers the value and displays up
to six of its digits in the cell.

Example 1: To select paired-variable and input the following data: (170,
66), (179, 75), (173, 68)
1. Press , select the Statistics app icon, and then press .
2. Select [2-Variable], and then press .
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3. Use the operation below to input data.

170 179 173
66 75 68

Note

• On the Statistics Editor, you can store the value in a cell to a variable. For example,
performing the following operation while the screen in step 3 is displayed above
will store 68 to variable A:  – [A=] > [Store]. For details about variables, see
"Variables (A, B, C, D, E, F, x, y, z)" (page 35).

Editing Sample Data

To replace the data in a cell
On the Statistics Editor, move the cursor to the cell containing the data you
want to edit, input the new data, and then press .

To delete a row
On the Statistics Editor, move the cursor to the row you want to delete and
then press .

To insert a row
1. On the Statistics Editor, move the cursor to the row that will be under

the row you will insert.
2. Perform the following operation:  – [Edit] > [Insert Row].

To delete all Statistics Editor contents
On the Statistics Editor, perform the following operation:  – [Edit] >
[Delete All].

Sorting Data

You can sort Statistics Editor data in ascending or descending order on its
x, y, or Freq-column values.

Important!

• Note that after you change the data sort sequence, you will not be able to return it to
its original sequence.
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Example 2: To sort the data input in Example 1 (page 67) in ascending
order on the x column, and then in descending order on the y column
1. Use the procedure in Example 1 to input the data.

2. Sort the data in ascending order on the x column.

 – [Sort] > [x Ascending]

3. Sort the data in descending order on the y column.

 – [Sort] > [y Descending]

Displaying Statistical Calculation Results

Displaying Single-Variable Statistical Calculation Results

The 1-Var Results screen shows a list of various statistical values (such
as mean and population standard deviation) calculated based on single-
variable data. This section describes the operation required to display the
1-Var Results screen.

Example 3: To input the data below and display single-variable statistical
calculation results

x 1 2 3 4 5 6 7 8 9 10
Freq 1 2 1 2 2 2 3 4 2 1

1. Press , select the Statistics app icon, and then press .
2. Select [1-Variable], and then press .

• This displays the Statistics Editor.
3. Press  and then select [Frequency] > [On].

• Press  to return to the Statistics Editor.
4. Input data into the x-column.

1 2 3 4 5 6 7 8 9 10

5. Input data into the Freq column.
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2 2 2 2 3 4 2

6. Press .

7. Select [1-Var Results], and then press .
• This displays the 1-Var Results screen.

 (or )

 (or )

• For the meanings of the variables shown on the 1-Var Results
screen, see the "List of Statistical Value Variables and Statistical
Calculation Functions" (page 76).

8. Press  or  to return to the Statistics Editor.

Displaying Paired-Variable Statistical Calculation Results

The 2-Var Results screen shows a list of various statistical values (such
as mean and population standard deviation) calculated based on paired-
variable data. This section describes the operation required to display the
2-Var Results screen.

Example 4: To input the data below and display paired-variable statistical
calculation results

x 1.0 1.2 1.5 1.6 1.9 2.1 2.4 2.5 2.7 3.0
y 1.0 1.1 1.2 1.3 1.4 1.5 1.6 1.7 1.8 2.0

1. Press , select the Statistics app icon, and then press .
2. Select [2-Variable], and then press .

• This displays the Statistics Editor.
3. Input data into the x-column.
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1 1 2 1 5 1 6 1 9
2 1 2 4 2 5 2 7 3

4. Input data into the y-column.

1 1 1 1 2 1 3 1 4
1 5 1 6 1 7 1 8 2

5. Press .

6. Select [2-Var Results], and then press .
• This displays the 2-Var Results screen.

 (or )

 (or )

 (or )

• For the meanings of the variables shown on the 2-Var Results
screen, see the "List of Statistical Value Variables and Statistical
Calculation Functions" (page 76).

7. Press  or  to return to the Statistics Editor.

Displaying Regression Calculation Results

The Reg Results screen displays a list of regression calculation results
(coefficients of regression equations) based on paired-variable data. This
section describes the operation required to display the Reg Results
screen.
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Example 5: To use the paired-variable data input in Example 4 (page 70)
and display the results of the two regression calculations shown below
• The regression equation "y = a + bx" coefficients (a, b), and the

correlation coefficient (r) when linear regression is performed on the
data

• The regression equation "y = a + bx + cx2" coefficients (a, b, c) when
quadratic regression is performed on the data

Note

• For information about regression calculation types supported by the Statistics app, see
the "Supported Regression Type List" (page 73).

1. Perform steps 1 through 5 of the procedure under Example 4 (page
70).

2. Select [Reg Results], and then press .
• This displays the regression type menu.

3. Select [y=a+bx], and then press .
• This displays the linear regression Reg Results screen.

4. Press  or  to return to the Statistics Editor.
5. Press , and then select [Reg Results] > [y=a+bx+cx2].

• This displays quadratic regression Reg Results screen.

6. Press  or  to return to the Statistics Editor.
• For the meanings of the variables shown on the Reg Results

screen, see the "List of Statistical Value Variables and Statistical
Calculation Functions" (page 76).
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Supported Regression Type List

Regression Type
Regression Equation

(regression type menu item)

Linear Regression y = a + bx

Quadratic Regression y = a + bx + cx2

Logarithmic Regression y = a + b･ln(x)

e exponential Regression y = a･e^(bx)

ab exponential Regression y = a･b^x

Power Regression y = a･x^b

Inverse Regression y = a + b/x

Using Statistical Calculation Screen
You can use the statistical calculation screen to recall individual statistical
values and use the values in calculations.

Screen without calculation expression input

Example calculation

To recall a statistical value, use a variable representing the statistical
value you want to recall (for example, x mean: x, x population standard
deviation: σx, x maximum value: max(x), and so on). For more information
about these variables, see the "List of Statistical Value Variables and
Statistical Calculation Functions" (page 76).
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Displaying a Statistical Calculation Screen

Single-variable
1. While the Statistics Editor is displayed, press .
2. On the menu that appears, select [Statistics Calc] and then press .

Paired-variable
1. While the Statistics Editor is displayed, press .
2. On the menu that appears, select [Statistics Calc] and then press .

• This displays the regression type menu (see the "Supported
Regression Type List" (page 73)).

3. On the menu, select the regression type you want and then press .

• In the example above, use the displayed menu to select [y=a+bx]
(Linear regression).

To return to the Statistics Editor from a statistical calculation screen
Press , and then .

Calculation Example Using the Statistical Calculation Screen

Example 6: To determine the sum of the sample data (Σx) and mean (x) of
the single-variable data input in Example 3 (page 69)
1. Perform steps 1 through 6 of the procedure under Example 3 (page

69).
2. Select [Statistics Calc], and then press .

3. Calculate the sum of the sample data (Σx).

74



 – [Statistics] > [Summation] > [Σx]

4. Calculate the mean (x).

 – [Statistics] >
[Mean/Var/Dev...] > [x]

Note

• To display the 1-Var Results screen from the statistical calculation screen above, press
 and then select [1-Var Results]. To return to the statistical calculation screen from

the 1-Var Results screen, press  or .

Example 7: To determine the coefficients (a, b) and correlation coefficient
(r) of the linear regression equation "y = a + bx" based on the paired-
variable data input in Example 4 (page 70)
1. Perform steps 1 through 5 of the procedure under Example 4 (page

70).
2. Select [Statistics Calc], and then press .

• This displays the regression type menu.

3. Select [y=a+bx], and then press .

4. Determine the coefficients (a, b) and correlation coefficient (r) of the
regression equation "y = a + bx".

 – [Statistics] > [Regression] > [a]

 – [Statistics] > [Regression] > [b]
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 – [Statistics] > [Regression] > [r]

• To select a different regression type, press  and then select [Select
Reg Type]. This displays the regression type menu from step 2.

To display the 2-Var Results screen from a statistical calculation
screen
Press  and then select [2-Var Results].

To display the Reg Results screen from a statistical calculation
screen
Press  and then select [Reg Results].

List of Statistical Value Variables and Statistical Calculation
Functions

You can use the CATALOG menu to recall variables representing
statistical values and functions used for statistical calculations.

Note

• For single-variable statistical calculations, the variables marked with an asterisk (*) are
available.

• For the calculation formula used for each variable and command, see "Statistical
Calculation Formula" (page 78).

 – [Statistics] > [Summation]
Σx*, Σy ...... sum of the sample data
Σx2*, Σy2 ...... sum of squares of the sample data
Σxy ...... sum of products of the x-data and y-data
Σx3 ...... sum of cubes of the x-data
Σx2y ...... sum of (x-data squares × y-data)
Σx4 ...... sum of biquadrate of the x-data

 – [Statistics] > [Mean/Var/Dev...]
x*, y ...... mean
σ2

x*, σ2
y ...... population variance

σx*, σy ...... population standard deviation
s2

x*, s2
y ...... sample variance

sx*, sy ...... sample standard deviation
n* ...... number of items

 – [Statistics] > [Min/Max/Quartile] (Single-Variable Data Only)
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min(x)* ...... minimum value
Q1* ...... first quartile
Med* ...... median
Q3* ...... third quartile
max(x)* ...... maximum value

 – [Statistics] > [Min/Max] (Paired-Variable Data Only)
min(x), min(y) ...... minimum value
max(x), max(y) ...... maximum value

 – [Statistics] > [Regression] (Paired-Variable Data Only)

For quadratic regression
a, b, c ...... regression coefficients for quadratic regression
x̂1, x̂2 ...... Functions for determining x1 and x2 estimated values for an
input y-value. For the argument, input the value of y immediately before
the x̂1 or x̂2 function.
ŷ ...... Function for determining the y estimated value for an input x-
value. For the argument, input the value of x immediately before this
function.

For non-quadratic regression
a, b ...... regression coefficients
r ...... correlation coefficient
x̂ ...... Function for determining x estimated value for an input y-value.
For the argument, input the value of y immediately before this function.
ŷ ...... Function for determining the y estimated value for an input x-
value. For the argument, input the value of x immediately before this
function.
For an example of the operation to determine estimated values, see
"Calculating Estimated Values (Paired-Variable Data Only)" (page
77).

Calculating Estimated Values (Paired-Variable Data Only)

Based on the regression equation obtained by paired-variable statistical
calculation, the estimated value of y can be calculated for a given x-value.
The corresponding x-value (two values, x1 and x2, in the case of quadratic
regression) also can be calculated for a value of y in the regression
equation.

Example 8: To determine the estimated value for y when x = 5.5 in the
regression equation produced by linear regression of the data input in
Example 4 (page 70)
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1. Perform steps 1 through 5 of the procedure under Example 4 (page
70).

2. Select [Statistics Calc], and then press .
• This displays the regression type menu.

3. Select [y=a+bx], and then press .

4. Input the x-value (5.5), and then input "ŷ", which is the function to
determine the estimated value of y.

5 5
 – [Statistics] > [Regression] > [ŷ]

5. Press .

Statistical Calculation Formula

Single-Variable Statistical Calculation Formula

Paired-Variable Statistical Calculation Formula
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Regression Calculation Formula

Linear Regression (y = a + bx)

Quadratic Regression (y = a + bx + cx2)

Logarithmic Regression (y = a + b･ln(x))
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e Exponential Regression (y = a･e^(bx))

ab Exponential Regression (y = a･b^x)

Power Regression (y = a･x^b)

Inverse Regression (y = a + b/x)
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Distribution Calculations
In the Distribution app, you can obtain the probability value by selecting
the distribution calculation type and inputting various parameters.*
Executable distribution calculation types are shown in the table below.

Distribution Calculation Type Menu Item

Binomial probability Binomial PD

Binomial cumulative probability Binomial CD

Normal probability density Normal PD

Normal cumulative probability Normal CD

Inverse normal cumulative distribution* Inverse Normal

Poisson probability Poisson PD

Poisson cumulative probability Poisson CD

* "Inverse Normal" performs inverse calculation to determine the data
value (xInv) from a probability value (Area1).

General Procedure for Performing a Distribution
Calculation

Example: To calculate binomial cumulative probability for the x data {2, 3,
4, 5} when N (number of trials) = 5 and p (probability of success) = 0.5
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1. Press , select the Distribution app icon, and then press .
• This displays the distribution calculation type menu.

2. On the menu, select a distribution calculation type.
• Here we want to calculate binomial cumulative probability. Select

[Binomial CD], and then press .
3. On the menu that appears, select a data (x) input method.

[List] ... Select to input multiple x-data items at the same time. Selecting
this menu item causes the list screen to appear.

[Variable] ... Select to input a single x-data item. Selecting this menu
item causes a parameter input screen to appear.

• Here we want to input multiple x-data items at the same time, select
[List] and then press .

4. On the list screen, input x data {2, 3, 4, 5}.

2 3 4 5

5. Press .
• This displays the Binomial CD parameter input screen.

6. Input values for the parameters (N = 5, p = 0.5).

5 0 5

• The parameters that require data input depend on the calculation
type you selected in step 2 of this procedure. For details, see the
"Parameter List" (page 83).

7. After inputting values for all of the variables, select [Execute] and then
press .
• This displays the calculation result screen.
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• If you selected [List] in step 3, calculation results (P column) will
appear on the list screen. For details, see "List Screen" (page 84).

• If you perform any editing operation (see "Editing the List Screen
Contents" (page 85)) on the list screen while calculation results are
displayed, all the calculation results will be cleared. The list will return
to its state in step 4 (list screen data input complete) of this procedure.

• An error message appears if the input value is outside the allowable
range. "ERROR" will appear in the P column of the calculation result
screen when the value input for the corresponding data is outside the
allowable range.

• Pressing  while the calculation result screen is displayed will return
to the parameter input screen.

Note

• If you selected Normal PD, Normal CD, or Inverse Normal in step 2 above, the data (x)
input method is always "Variable" (single x-data item input). Because of this, the menu
in step 3 is not displayed at this time.

• If the data (x) input method is "Variable", the calculation result will be stored in Ans
memory.

• Distribution calculation accuracy is up to 6 significant digits.

Parameter List
The list below shows the meanings of the symbols that appear on the
parameter input screen.

Binomial PD, Binomial CD
x … data
N … number of trials
p … probability of success (0 ≤ p ≤ 1)

Normal PD
x … data
μ … population mean
σ … population standard deviation (σ > 0)

Normal CD
Lower … lower boundary
Upper … upper boundary
μ … population mean
σ … population standard deviation (σ > 0)

Inverse Normal
Area1 … probability value (0 ≤ Area1 ≤ 1)
μ … population mean

83



σ … population standard deviation (σ > 0)
(Tail setting always left.)

Poisson PD, Poisson CD
x … data
λ … mean

Note

• The last value input for each parameter name is retained, regardless of the input
screen where it is input. For example, inputting a value for N on the Binomial PD
parameter input screen will also change the value of N on the Binomial CD parameter
input screen.

• The values you input for each of the parameters are retained as long as you do not
execute either of the following operations:  – [Reset] > [Settings & Data] or  –
[Reset] > [Initialize All].

List Screen
You can use the list screen to input up to 45 x-data items. Calculation
results are also displayed on the list screen.

(1) Distribution calculation type
(2) Value at current cursor position
(3) Data (x)
(4) Calculation results (P)

Note

• On the list screen, you can store the value in a cell to a variable. For example,
performing the following operation while the above screen is displayed will store 1 to
variable A:  – [A=] > [Store]. For details about variables, see "Variables (A, B, C,
D, E, F, x, y, z)" (page 35).

• Performing one of the operations below deletes all x-data input on the list screen.
- Returning to the HOME screen and launching another calculator app
- Executing [Delete All] (See "To delete all list screen contents" (page 85).)
- Executing  – [Reset] > [Settings & Data] or  – [Reset] > [Initialize All]
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Editing the List Screen Contents

To change the x data in a cell

On the list screen, move the cursor to the cell containing the data you want
to change, input the new data, and then press .

To delete a row

On the list screen, move the cursor to the row you want to delete and then
press .

To insert a row

1. On the list screen, move the cursor to the row that will be under the row
you will insert.

2. Perform the following operation:  – [Edit] > [Insert Row].
• This inserts a row with 0 input as the initial default value.

3. Input the data.

To delete all list screen contents

On the list screen, perform the following operation:  – [Edit] > [Delete
All].

Calculation Example
To calculate the normal probability density when x = 36, μ = 35, σ = 2
1. Press , select the Distribution app icon, and then press .
2. On the distribution calculation type menu that appears, select [Normal

PD], and then press .
• This displays the Normal PD parameter input screen.

3. Input values for the parameters (x = 36, μ = 35, σ = 2).

36 35 2

4. Press .
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• Pressing  again or pressing  or  returns to the parameter input
screen in step 3 of this procedure.

• You can store the currently displayed calculation result to a variable.
For example, performing the following operation while the screen in
step 4 is displayed above will store the calculation result to variable A:

 – [A=] > [Store]. For details about variables, see "Variables (A, B,
C, D, E, F, x, y, z)" (page 35).

Creating a Number Table
You can use the Table app to create a number table based on the defining
equations registered for functions f(x) and g(x).

General Procedure for Creating a Number Table

Example : To generate a number table for the functions f(x) = x2 + 1
2  and

g(x) = x2 - 1
2  for the range -1 ≤ x ≤ 1, incremented in steps of 0.5

1. Press , select the Table app icon, and then press .
• This displays the number table screen.
• If a defining equation is not registered for either or both of f(x) and

g(x) and the data at the cursor selection position is empty, a message
will appear at the bottom of the screen indicating that the defining
equation is not registered.

2. Configure settings to generate a number table from two functions.
(1) Press , and then select [Table Type] > [f(x)/g(x)].
(2) Press .
• For information about settings, see "Maximum Number of Rows in a

Number Table According to Table Type" (page 87).
3. Register a defining equation for f(x).

 – [Define f(x)/g(x)] > [Define f(x)]
1 2

(Screen immediately before you pressed )
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4. Register a defining equation for g(x).

 – [Define f(x)/g(x)] > [Define g(x)]
1 2

(Screen immediately before you pressed )

• You can also use  to register a defining expression. For more
information, see "Defining Equation Registration" (page 88).

5. Configure the number table range setting.

 – [Table Range]
((-))1 1 0 5

6. Press .
• This displays the result in the number table screen.

• The number table generation operation causes the contents of
variable x to be changed.

Note

• On the number table screen, you can store the value in a cell to a variable. For
example, performing the following operation while the screen in step 6 is displayed
above will store -1 to variable A:  – [A=] > [Store]. For details about variables, see
"Variables (A, B, C, D, E, F, x, y, z)" (page 35).

Maximum Number of Rows in a Number Table
According to Table Type

You can configure number table screen settings to show columns for both
f(x) and g(x), or for either one of them. To set it, use the menu that
appears when you press  – [Table Type] while the number table screen
is displayed.

f(x)/g(x) ... Show both f(x)- and g(x)-columns (initial default setting)
f(x) ... Show only f(x)-column
g(x) ... Show only g(x)-column
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The maximum number of rows in the generated number table depends on
the Table Type setting. Up to 45 rows are supported for the "f(x)" or "g(x)"
setting, while 30 rows are supported for the "f(x)/g(x)" setting.

Defining Equation Registration
There are two ways to register defining equations for f(x) and g(x).
• While the Table app number table screen is displayed, registering an

equation by pressing 
 – [Define f(x)/g(x)] > [Define f(x)]
 – [Define f(x)/g(x)] > [Define g(x)]

• While the Table app number table screen is displayed, or while using
any calculator app except Distribution, registering an equation by
pressing 

 – [Define f(x)]
 – [Define g(x)]

The same f(x) or g(x) equation registration screen appears regardless of
which of the two above operations is used to register defining equations.

Note

• For details about operations using , see "Registering and Using Defining
Equations for f(x) and g(x)" (page 56).

Editing Number Table Screen Data

To delete a row

1. On the number table screen, move the cursor to the row you want to
delete.

2. Press .

To insert a row

1. On the number table screen, move the cursor to the row that will be
under the row you will insert.

2. Perform the following operation:  – [Edit] > [Insert Row].

To delete all number table screen contents

On the number table screen, perform the following operation:  – [Edit] >
[Delete All].
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To change the value input in a cell in column x

You can change the value in the currently highlighted x cell. Changing the
x value causes the f(x) and g(x) values in the same row to be updated
accordingly.

To enter a value into the highlighted x-column cell using:
{value of the cell above} +/- {step value}

If there is value in the x cell above the currently highlighted x cell, pressing
 or  automatically inputs into the highlighted cell the value equal to

the value of the cell above it plus the step value. So also, pressing 
automatically inputs the value equal to the value of the cell above less
the step value. The f(x) and g(x) values in the same row are also updated
accordingly.

f(x) and g(x) Update Timing
f(x) and g(x) values displayed on the number table screen are updated
when any of the following occurs.
• When  is pressed while [Execute] is selected on the Table Range

screen.
• When the defining equations for f(x) and g(x) are updated (except when

a defining equation is a composite function).
• When a number is input into column x (including pressing , ,  in

column x).
• When Verify is switched from enabled to disabled (  – [Verify OFF]).

Note, however, that values are not updated automatically after the
following operations.
• When the SETTINGS menu is used to change the Angle Unit setting.
• When the variable of a defining equation is updated (new numeric value

stored) when a defining equation that contains a variable (example: f(x)
= 2x + A) is registered.

• When the defining equation of a composite function (Example: g(x) = f(x)
× 2 - x) is registered, and the defining equation of the reference function
(Example: f(x) of g(x) = f(x) × 2 - x) is updated (new defining equation
registered).

In these cases, execute  – [Recalculate] while the number table screen
is displayed to update values.

Using Verify with the Table App
If Verify is enabled in the Table app, every time you input an f(x) value
(or a g(x) value) that corresponds to x on the number table screen, the
calculator will determine if the value is true.
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Note

• Verify can be used with various calculator apps. Before performing the operations in
this section, first read the information in "Verify Overview" (page 59).

Verify Sample Operation

This sample operation begins with a number table that has been created
according to the following settings.

Defining equation ...... f(x) = x2 + 1
2       g(x) = x2 - 1

2
Table Range ......... Start: -1, End: 1, Step: 0.5

Perform the procedure continuing from step 6 under "General Procedure
for Creating a Number Table" (page 86).
1. To enable Verify, press  and then select [Verify ON].

• An  indicator appears at the top of the screen to indicate that Verify
is enabled.

• This deletes all of the contents of the f(x)- and g(x)-columns of the
number table screen.

2. Press  to move the cursor to the first row of column f(x).

3. Input the f(x) value (1.5) that corresponds to x = 1.

1 5

• "True" is displayed if the input value is true.
• "False" is displayed if the input value is false. Press , , or  to

return to the number table screen and re-input the number.
4. If "True" is displayed, press , , or .

• This returns to the number table screen and moves the cursor to the
next row.
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• You can continue to input f(x) and g(x) values for x. Each time you
input a value, the calculator determines whether it is true.

5. To disable Verify and end the Verify operation, press  and then select
[Verify OFF].
• This causes the  indicator to disappear from the screen.
• For details about the operation to disable Verify, see "To disable

Verify" (page 60).
• Any changes you made to or new values you input into the x-column

values of the number table screen while Verify was enabled are
retained. When you disable Verify, the f(x)- and g(x)-columns are
recalculated in accordance with the values in the x-column.

Note

• If the verification result is "True", the value input into the f(x)- or g(x)-column can be
stored to a variable. For example, performing the following operation while the screen
in step 4 is displayed above will store 1.5 to variable A:  – [A=] > [Store]. For
details about variables, see "Variables (A, B, C, D, E, F, x, y, z)" (page 35).

• You can change the value in a cell by moving the cursor to the cell in column x and
inputting a new value. Changing the value in an x cell causes the values in columns
f(x) and g(x) to be deleted.

• You can also input a value into an x-column cell that does not contain a value (if the
maximum number of rows is not exceeded yet). For information about the maximum
number of rows, see "Maximum Number of Rows in a Number Table According to
Table Type" (page 87).

• Pressing  while Verify is enabled disables Verify and simultaneously deletes all
data currently input in the number table.

To delete all the contents of the f(x)- and g(x)-columns

When Verify is enabled, the contents of the f(x)- and g(x)-columns can
be batch deleted. On the number table screen, perform the following
operation:  – [Edit] > [Delete f/g Column].

Data Retention
Doing the following will discard some data and clear some settings of the
Table app.① Returning to the HOME screen and launching another calculator

app.② Pressing .③ Changing the Input/Output setting with the SETTINGS menu.④ Changing the Table Type setting with the TOOLS menu.
The table below shows which data is discarded and which data is retained.
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Operation

Data, Setting
① ② ③ ④

Number table data
(x-, f(x)-, g(x)-columns) Discarded Retained Discarded Discarded

Table Range settings Discarded Retained Retained Retained
Table Type settings Retained Retained Retained --
f(x), g(x) defining
equations Retained Retained Discarded Retained

Complex Number Calculations
To perform complex number calculations, first launch the Complex app.
Press , select the Complex app icon, and then press .

Inputting Complex Numbers
You can use either rectangular coordinates (a+bi) or polar coordinates
(r∠θ) to input complex numbers.

Example 1: To input 2+3i

2 3 (i)*

* You can also use the following operation to input i:  – [Complex] > [i].

Example 2: To input 5∠30

5  – [Complex] > [∠] 30

Complex App Calculation Examples

Before Performing the Example Operations

• For the examples in this section, use the SETTINGS menu to select
MathI/MathO for the Input/Output setting. Configure other settings as
shown for each example.

• Complex number calculation results are displayed in accordance with
the Complex Result setting on the SETTINGS menu.

• If you are planning to perform input and display of the calculation result
in polar coordinate format, specify the Angle Unit on the SETTINGS
menu before starting the calculation.

• The θ value of the calculation result is displayed in the range of -180° <
θ ≤ 180°.

• Display of the calculation result while something other than MathI/MathO
is selected will show a and bi (or r and θ) on separate lines.
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Example 3: (1 + i)4 + (1 - i)2 = -4 - 2i
(Complex Result: a+bi)

1 (i) 4
1 (i)

Note

• When raising a complex number to an integer power using the syntax (a+bi)n, the
power value can be within the following range: -1 × 1010 < n < 1 × 1010.

Example 4: 2∠45 = √2 + √2i
(Angle Unit: Degree, Complex Result: a+bi)

2  – [Complex] > [∠] 45

Example 5: √2 + √2i = 2∠45
(Angle Unit: Degree, Complex Result: r∠θ)

2 2 (i)

Example 6: To obtain the conjugate complex number of 2 + 3i
(Complex Result: a+bi)

 – [Complex] > [Conjugate]
2 3 (i)

Example 7: To obtain the absolute value and argument of 1 + i
(Angle Unit: Degree)

 – [Numeric Calc] > [Absolute Value]
1 (i)

 – [Complex] > [Argument]
1 (i)

93



Example 8: To extract the real part and imaginary part of 2 + 3i

 – [Complex] > [Real Part]
2 3 (i)

 – [Complex] > [Imaginary Part]
2 3 (i)

Converting a Complex Number Calculation Result to
Rectangular or Polar Coordinates

You can use the FORMAT menu that appears when you press  to
convert a complex number calculation result to rectangular coordinate or
polar coordinate format.

Example 9: √2 + √2i = 2∠45, 2∠45 = √2 + √2i
(Angle Unit: Degree, Complex Result: a+bi)

2 2 (i)

 – [Polar Coord]

 – [Rectangular Coord]

Using Verify with the Complex App
After enabling Verify in the Complex app, you can determine if an equation
or inequality is true. With the Complex app, you can determine whether an
equation that includes a complex number is true or false.

Note

• Verify can be used with various calculator apps. Before performing the operations in
this section, first read the information in "Verify Overview" (page 59).

• Whether an inequality that includes a complex number is true or false cannot be
determined (Math ERROR).

• When Verify is enabled with the Complex app, the following items are the same as
those for the Calculate app.
- "Verifiable Expressions" (page 61)
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- "Performing a Sequential Verification Operation on the Right Side of an
Expression" (page 61)

Example Verify Operation

Example 10: To determine whether i2 = -1 is true
1. To enable Verify, press  and then select [Verify ON].

• An  indicator appears at the top of the screen to indicate that Verify
has been enabled.

2. Input i2 = -1 and determine if it is true.

(i)
(=) ((-))1

3. To disable Verify and exit the Verify operation, press  and then select
[Verify OFF].
• This causes the  indicator to disappear from the screen.
• For information about how to disable Verify, see "To disable Verify"

(page 60).

Vector Calculations
Use the Vector app to perform two-dimensional and three-dimensional
vector calculations.

General Procedure for Performing a Vector
Calculation

To perform a vector calculation, use the special vector variables (VctA,
VctB, VctC, VctD) as shown in the example below.

Example 1: To calculate (1, 2) + (3, 4)
• When performing addition or subtraction of two vectors, they both must

have the same dimensions.
1. Press , select the Vector app icon, and then press .

• This displays the vector calculation screen.

2. Press .
• This displays the vector variable list screen.

95



• For details about the vector variable list screen contents, and how to
perform vector variable store, edit, or other operations, see "Vector
Variable List Screen" (page 97).

3. Perform the steps below to store (1, 2) to VctA.
(1) Select [VctA:], and then press .

• This displays the vector dimension setting screen (initial default
setting: 2 dimensions).

(2) Here, we want to store a two-dimensional vector, so select [Confirm]
and then press .

• This displays the Vector Editor for input of the two-dimensional
vector for VctA.

(3) Input the elements of VctA.

1 2

(4) Press , , or  to return to the vector calculation screen.
4. Perform the steps below to store (3, 4) to VctB.

(1) Press , select [VctB:], and then press .
(2) Select [Confirm], and then press .
(3) Input the elements of VctB.

3 4

(4) Press , , or  to return to the vector calculation screen.
5. Input VctA+VctB.

 – [Vector] > [VctA]
 – [Vector] > [VctB]
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6. Press .
• This displays the VctAns (Vector Answer Memory) screen with the

calculation result.

• For details about VctAns, see "Vector Answer Memory (VctAns)"
(page 99).

• Pressing  while the VctAns screen is displayed returns to the vector
calculation screen and clears the calculation expression. Pressing 
or  returns to the calculation expression input complete state in
step 5 of this procedure.

Note

• While the Vector Editor or the VctAns screen is displayed, you can store the currently
highlighted value to a variable. While the vector calculation screen is displayed and a
calculation result value is on the screen, you can store the displayed calculation result
to a variable. For details about variables, see "Variables (A, B, C, D, E, F, x, y, z)"
(page 35).

Vector Variable List Screen
The vector variable list screen is the entry portal you should use when
you want to store a vector into vector variable VctA, VctB, VctC, or VctD,
or to edit a previously stored vector. The status of each vector variable is
indicated as shown in the examples below.

(1) 2
Indicates a two-dimensional vector is stored to the vector variable.

(2) None1
Indicates that nothing is stored to the vector variable.

Displaying the vector variable list screen

Depending on the currently displayed screen, perform one of the
operations below.
• When the vector calculation screen is displayed:

Press .
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• When the Vector Editor or VctAns screen is displayed:
Press , select [Define Vector], and then press .

Storing New Data to a Vector Variable

Example 2: To store the three-dimensional vector (1, 2, 3)
1. While the vector calculation screen is displayed, press  to display the

vector variable list screen.
2. Select the vector variable (VctA, VctB, VctC, or VctD) to which you want

to store new data, and then press .
• If you selected a vector variable whose status is "None1", advance to

step 4 of this procedure.
• If you selected a vector variable that already has a vector stored to it,

a menu screen will appear. Advance to step 3.

3. Select [Define New], and then press .
4. On the "Vector Dimension?" screen that appears, specify the vector

dimension.

• To specify three dimensions, perform the steps below.
(1) Select [Dimensions] and then press .
(2) On the menu that appears, select [3 Dimensions] and then press .

5. After the dimension specification is the way you want, select [Confirm]
and then press .
• This displays the Vector Editor.

6. Input the elements of the vector variable.

1 2 3

7. Press , , or  to return to the vector calculation screen.
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Note

• Vector variable contents are retained even if you press , change the calculator
app, or turn off the calculator. Executing any one of the operations below causes the
contents of all vector variables to be cleared.
-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All]

Editing Vector Variable Data

1. While the vector calculation screen is displayed, press  to display the
vector variable list screen.

2. Select the vector variable (VctA, VctB, VctC, or VctD) you want to edit,
and then press .

3. On the menu that appears, select [Edit] and then press .
• This displays the Vector Editor.

4. Use the Vector Editor to edit the elements of the vector.
• Move the cursor to the cell that contains the element you want to

change, input the new value, and then press .
5. Press , , or  to return to the vector calculation screen.

Copying Vector Variable (or VctAns) Contents

1. Display the Vector Editor or VctAns screen of the vector variable you
want to use as the copy source.
• To display the Vector Editor, perform steps 1, 2, and 3 under "Editing

Vector Variable Data" (page 99).
• To display the VctAns screen, perform the steps below while the

vector calculation screen is displayed.
 – [Vector] > [VctAns] 

2. Select the vector variable copy destination.
• For example, to copy to VctD, perform the following operation:  –

[Store] > [VctD].
• This displays the Vector Editor with the contents of the copy

destination.
3. Press , , or  to return to the vector calculation screen.

Vector Answer Memory (VctAns)
Whenever the result of a calculation executed in the Vector app is a
vector, the VctAns screen will appear with the result. The result also will be
stored to a variable named "VctAns".

The VctAns variable can be used in calculations as described below.
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• To insert the VctAns variable into a calculation, perform the following
operation:  – [Vector] > [VctAns].

• Pressing any one of the following keys while the VctAns screen is
displayed switches automatically to the vector calculation screen, with
"VctAns" followed by the operator or function of the key you pressed:

, , , , , , , ( ), ( ).

Note

• VctAns contents are retained even if you press  or turn off the calculator.
Performing any one of the operations below causes the VctAns contents to be cleared.
- Returning to the HOME screen and launching another calculator app
- Executing  – [Reset] > [Settings & Data]
- Executing  – [Reset] > [Initialize All]

Vector Calculation Examples
The examples below use VctA = (1, 2) and VctB = (3, 4), and VctC = (2,
-1, 2).

Example 3: VctA • VctB (Vector dot product)

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Dot Product]

 – [Vector] > [VctB]

Note

• When calculating a dot product, the dimensions of the two vectors must be the same.

Example 4: VctA × VctB (Vector cross product)

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Cross Product]

 – [Vector] > [VctB]

Note

• When calculating a cross product, the dimensions of the two vectors must be the
same.
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Example 5: To obtain the absolute values of VctC

 – [Numeric Calc] > [Absolute Value]
 – [Vector] > [VctC]
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Technical Information

Errors
The calculator will display an error message whenever an error occurs for
any reason during a calculation.

Displaying the Location of an Error
While an error message is displayed, pressing , , or  returns
to the screen that was displayed immediately before the error message
appeared. The cursor will be positioned at the location where the
error occurred, ready for input. Make the necessary corrections to the
calculation and execute it again.

Example: When you input 14 ÷ 0 × 2 by mistake instead of 14 ÷ 10 × 2.

14 0 2

 (or  or )

1

Error Messages

Syntax ERROR

Cause:
• There is a problem with the format of the calculation you are

performing.
Action:
• Make necessary corrections.

Math ERROR

Cause:
• The intermediate or final result of the calculation you are performing

exceeds the allowable calculation range.
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• Your input exceeds the allowable input range (particularly when using
functions).

• The calculation you are performing contains an illegal mathematical
operation (such as division by zero).

• While using an app that does not support complex numbers or while
a screen that does not accept input of complex numbers is displayed,
you attempted to execute a calculation that includes a variable where
a complex number is stored.

• When Verify is enabled (Verify ON) while using the Complex app, you
entered an inequality that includes a complex number.

Action:
• Check the input values, reduce the number of digits, and try again.
• When using a variable as the argument of a function, make sure that

the variable value is within the allowable range for the function.
• To execute a calculation that includes a variable where a complex

number is stored, while using an app that does not support complex
numbers or while a screen that does not accept input of complex
numbers is displayed, change the value stored to the variable to a
real number.

• You cannot use Verify in the Complex app to determine if an inequality
that includes a complex number is true. You can determine the truth of
an equation that includes a complex number.

Stack ERROR

Cause:
• The calculation you are performing has caused the capacity of the

numeric stack or the command stack to be exceeded.
Action:
• Simplify the calculation expression so it does not exceed the capacity

of the stack.
• Try splitting the calculation into two or more parts.

Argument ERROR

Cause:
• There is a problem with the argument of the calculation you are

performing.
Action:
• Make necessary corrections.
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Dimension ERROR (Vector app only)

Cause:
• You are trying to perform a calculation with vectors whose dimensions

do not allow that type of calculation.
Action:
• Check the dimensions specified for the vectors to see if they are

compatible with the calculation.

Range ERROR (Table app only)

Cause:
• An attempt to generate a number table in the Table app whose

conditions cause it to exceed the maximum number of allowable rows.
Action:
• Narrow the table calculation range by changing the Start, End, and

Step values, and try again.

Time Out (Distribution app only)

Cause:
• The current distribution calculation ends without the ending condition

being fulfilled.
Action:
• Change the value of each parameter.

Circular ERROR (f(x) and g(x) feature only)

Cause:
• Circular reference is occurring in a registered composite function

("Registering a Composite Function" (page 57)).
Action:
• Do not have g(x) input into f(x), and f(x) input into g(x) at the same

time.

No Operator (Calculate and Complex apps only)

Cause:
• You entered an expression that does not include an operator and tried

to determine if it is true.
Action:
• Enter an equation or inequality and then determine if it is true.
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Not Defined

Cause (f(x) and g(x) feature):
• You attempted to calculate f(x) or g(x) with f(x)/g(x) undefined.

Action:
• Define f(x) or g(x) before calculating f(x)/g(x).

Cause (Vector app):
• The vector you are trying to use in a calculation was input without

specifying its dimension.
Action:
• Specify the dimension of the vector and then perform the calculation

again.

Before Assuming Malfunction of the
Calculator...
Note that you should make separate copies of important data before
performing these steps.
1. Check the calculation expression to make sure that it does not contain

any errors.
2. Make sure that you are using the correct calculator app for the type of

calculation you are trying to perform.
• To check which calculator app you are currently using, press . This

highlights the icon of the calculator app currently in use.
3. If the above steps do not correct your problem, press the  key.

• This causes the calculator to perform a routine that checks whether
calculation functions are operating correctly. If the calculator discovers
any abnormality, it automatically initializes the calculator app and
clears memory contents.

4. Return the calculator settings (except for Contrast and Auto Power Off)
to their initial default settings by performing the procedure below.
(1) Press , select a calculator app icon, and then press .
(2) Press , and then select [Reset] > [Settings & Data] > [Yes].

Replacing the Battery
If the screen shown below appears right after you turn on power, it means
that remaining battery power is low.
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A low battery is also indicated by a dim display, even if contrast is
adjusted, or by failure of figures to appear on the display immediately after
you turn on the calculator.
If this happens or the above screen appears, replace the battery with a
new one.

Important!

• Removing the battery causes all of the calculator’s memory contents to be cleared.

1. Press (OFF) to turn off the calculator.
• To ensure that you do not accidentally turn on power while replacing

the battery, attach the front cover to the front of the calculator.
2. As shown in the illustration, remove the battery cover, remove the

battery, and then load a new battery with its plus (+) and minus (−)
ends facing correctly.

3. Replace the battery cover.
4. Press  to turn on the calculator.
5. Initialize the calculator.

(1) Press , select a calculator app icon, and then press .
(2) Press , and then select [Reset] > [Initialize All] > [Yes].
• Do not skip the above steps!
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Calculation Priority Sequence
The calculator performs calculations according to a calculation priority
sequence.

• Basically, calculations are performed from left to right.
• Expressions within parentheses have the highest priority.
• The following shows the priority sequence for each individual command.

1 Parenthetical expressions

2
Functions that have parentheses (sin(, log(, f(, g(, etc.,
functions that take an argument to the right, functions that
require a closing parenthesis after the argument)

3
Functions that come after the input value (x2, x-1, x!, °’ ”, °, r,
g, %), powers ( ), roots ( )

4 Fractions

5 Negative sign ((-))

6 Statistics app estimated values (x̂, ŷ, x̂1, x̂2)

7 Multiplication where the multiplication sign is omitted

8
Permutation (nPr), combination (nCr), complex number polar
coordinate symbol (∠)

9 Dot product (•)

10 Multiplication (×), division (÷)

11 Addition (+), subtraction (−)

If a calculation contains a negative value, you may need to enclose
the negative value in parentheses. If you want to square the value -2,
for example, you need to input: (-2)2. This is because x2 is a function
preceded by a value (Priority 3, above), whose priority is greater than the
negative sign, which is a prefix symbol (Priority 5).

Example:
((-))2     -22 = -4

((-))2  (-2)2 = 4
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Calculation Ranges, Number of
Digits, and Precision
The calculation range, number of digits used for internal calculation, and
calculation precision depend on the type of calculation you are performing.

Calculation Range and Precision

Calculation Range ±1 × 10-99 to ±9.999999999 × 1099 or 0

Number of Digits for
Internal Calculation

23 digits

Precision

In general, ±1 at the 10th digit for a single
calculation. Precision for exponential
display is ±1 at the least significant digit.
Errors are cumulative in the case of
consecutive calculations.

Function Calculation Input Ranges and Precision

Functions Input Range

sinx
cosx

Degree 0 ≤ |x| < 9 × 109

Radian 0 ≤ |x| < 157079632.7

Gradian 0 ≤ |x| < 1 × 1010

tanx

Degree
Same as sinx, except when
|x| = (2n - 1) × 90.

Radian
Same as sinx, except when
|x| = (2n - 1) × π/2.

Gradian
Same as sinx, except when
|x| = (2n - 1) × 100.

sin-1x, cos-1x 0 ≤ |x| ≤ 1

tan-1x 0 ≤ |x| ≤ 9.999999999 × 1099

sinhx, coshx 0 ≤ |x| ≤ 230.2585092
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sinh-1x 0 ≤ |x| ≤ 4.999999999 × 1099

cosh-1x 1 ≤ x ≤ 4.999999999 × 1099

tanhx 0 ≤ |x| ≤ 9.999999999 × 1099

tanh-1x 0 ≤ |x| ≤ 9.999999999 × 10-1

logx, lnx 0 < x ≤ 9.999999999 × 1099

10x -9.999999999 × 1099 ≤ x ≤ 99.99999999

√x 0 ≤ x < 1 × 10100

x2 |x| < 1 × 1050

x-1 |x| < 1 × 10100; x ≠ 0

x! 0 ≤ x ≤ 69 (x is an integer)

nPr
0 ≤ n < 1 × 1010, 0 ≤ r ≤ n (n, r are integers)
1 ≤ {n!/(n - r)!} < 1 × 10100

nCr
0 ≤ n < 1 × 1010, 0 ≤ r ≤ n (n, r are integers)
1 ≤ n!/r! < 1 × 10100 or 1 ≤ n!/(n - r)! < 1 × 10100

Pol(x, y)
|x|, |y| ≤ 9.999999999 × 1099

√x2 + y2 ≤ 9.999999999 × 1099

Rec(r, θ)
0 ≤ r ≤ 9.999999999 × 1099

θ: Same as sinx

a°b’c”
|a|, b, c < 1 × 10100; 0 ≤ b, c
The display seconds value is subject to an error
of ±1 at the second decimal place.

a°b’c” = x
0°0’0” ≤ |x| ≤ 9999999°59’59”
A sexagesimal value outside of the above range
is automatically treated as a decimal value.

xy

x > 0: -1 × 10100 < ylogx < 100
x = 0: y > 0

x < 0: y = n, m
2n + 1 (m, n are integers)

However: -1 × 10100 < ylog |x| < 100
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x
√y

y > 0: x ≠ 0, -1 × 10100 < 1/x logy < 100
y = 0: x > 0

y < 0: x = 2n + 1, 2n + 1
　 m　

 (m ≠ 0; m, n are integers)

However: -1 × 10100 < 1/x log |y| < 100

a b/c
Total of integer, numerator, and denominator
must be 10 digits or less (including separator
symbol).

RanInt#(a, b) a < b; |a|, |b| < 1 × 1010; b - a < 1 × 1010

GCD(a, b) |a|, |b| < 1 × 1010 (a, b are integers)

LCM(a, b) 0 ≤ a, b < 1 × 1010 (a, b are integers)

• Precision is basically the same as that described under "Calculation
Range and Precision", above.

• xy, 
x
√y, x!, nPr, nCr type functions require consecutive internal calculation,

which can cause accumulation of errors that occur with each calculation.
• Error is cumulative and tends to be large in the vicinity of a function’s

singular point and inflection point.
• The range for calculation results that can be displayed in π form when

MathI/MathO is selected for Input/Output on the SETTINGS menu is
|x| < 106. Note, however, that internal calculation error can make it
impossible to display some calculation results in π form. It also can
cause calculation results that should be in decimal form to appear in π
form.

Specifications
Power Requirements:
AAA-size battery R03 × 1

Approximate Battery Life:
2 years (based on one hour of operation per day)

Power Consumption:
0.0008 W

Operating Temperature:
0°C to 40°C (32°F to 104°F)
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Dimensions:
13.8 (H) × 77 (W) × 162 (D) mm
9/16” (H) × 3 1/16” (W) × 6 3/8” (D)

Approximate Weight:
100 g (3.5 oz) including the battery
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Frequently Asked Questions

Frequently Asked Questions
■ How can I change a fraction form result produced by a division

operation to decimal form?
→ While a fraction calculation result is displayed, press  and then select

[Decimal], or press ( ). To have calculation results initially appear
as decimal values, change the Input/Output setting on the SETTINGS
menu to MathI/DecimalO.

■ What is the difference between Ans memory, PreAns memory, and
variable memory?

→ Each of these types of memory acts like "containers" for temporary
storage of a single value.
Ans Memory: Stores the result of the last calculation performed. Use
this memory to carry the result of one calculation on to the next.
PreAns Memory: Stores the result of calculation before the last one.
PreAns memory can be used only in the Calculate app.
Variables: This memory is helpful when you need to use the same
value multiple times in one or more calculations.

■ How can I find a function I was using with an older CASIO
calculator model on this calculator?

→ This calculator’s functions can be accessed from the CATALOG menu
that appears when you press . For details, see the sections below.
"Using the CATALOG Menu" (page 23)
"Advanced Calculations" (page 46)

■ With an older CASIO calculator model, I pressed  to change
the calculation result display format. What should I do with this
calculator?

→ While a calculation result is displayed, press . Use the menu
that appears to select the display format you want. For details, see
"Changing Calculation Result Format" (page 38).

■ How can I find out which calculator app I am currently using?
→ Press . This causes the icon of the calculator app you are currently

using to become highlighted.

■ How do I calculate sin2 x

→ For example, to calculate sin2 30 =  1
4 , enter the calculation below.
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30

■ Why can’t I input (i) or calculate a complex number?
→ You cannot use the Calculate app to input i or to perform complex

number calculations. Use the Complex app for such calculations.

■ Why doesn’t the Verify indicator ( ) disappear?
→ To make the  indicator that appears while Verify is enabled (Verify

ON) disappear, perform the following operation:  – [Verify OFF].
For more information about Verify, see "Using Verify" (page 59).

■ Why does the battery icon ( ) appear right after the calculator is
turned on?

→ The battery icon indicates that battery power is low. If you see this
icon, replace the battery as soon as possible. For details about battery
replacement, see "Replacing the Battery" (page 105).

■ How can I return the calculator to its initial default settings?
→ Perform the procedure below to initialize calculator settings (except for

Contrast and Auto Power Off).
(1) Press , select a calculator app icon, and then press .
(2) Press , and then select [Reset] > [Settings & Data] > [Yes].
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